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Preface

Profile

Prerequisites

• R11i Navigating Oracle Applications

How This Course Is Organized

This course is an instructor-led course featuring lecture and hands-on exercises.
Online demonstrations and written practice sessions reinforce the concepts and
skills introduced.
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Related Publications

Oracle Publications

Additional Publications

• System release bulletins

• Installation and user’s guides

• read.me files

• Oracle Magazine
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Typographic Conventions

Typographic Conventions in Text

Convention Element Example
Bold italic Glossary term (if

there is a glossary)
The algorithm inserts the new key.

Caps and
lowercase

Buttons,
check boxes,
triggers,
windows

Click the Executable button.
Select the Can’t Delete Card check box.
Assign a When-Validate-Item trigger to the
ORD block.
Open the Master Schedule window.

Courier new,
case sensitive
(default is
lowercase)

Code output,
directory names,
filenames,
passwords,
pathnames,
URLs,
user input,
usernames

Code output: debug.set (‘I”, 300);
Directory: bin (DOS), $FMHOME (UNIX)
Filename: Locate the init.ora file.
Password: User tiger as your password.
Pathname: Open c:\my_docs\projects
URL: Go to http://www.oracle.com
User input: Enter 300
Username: Log on as scott

Initial cap Graphics labels
(unless the term is a
proper noun)

Customer address (but Oracle Payables)

Italic Emphasized words
and phrases,
titles of books and
courses,
variables

Do not save changes to the database.
For further information, see Oracle7 Server
SQL Language Reference Manual.
Enter user_id@us.oracle.com,
where user_id is the name of the user.

Quotation
marks

Interface elements
with long names
that have only
initial caps;
lesson and chapter
titles in cross-
references

Select “Include a reusable module component”
and click Finish.

This subject is covered in Unit II, Lesson 3,
“Working with Objects.”

Uppercase SQL column
names, commands,
functions, schemas,
table names

Use the SELECT command to view
information stored in the LAST_NAME
column of the EMP table.

Convention Element Example
Arrow Menu paths Select File—> Save.
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Brackets Key names Press [Enter].

Commas Key sequences Press and release keys one at a time:
[Alternate], [F], [D]

Plus signs Key combinations Press and hold these keys simultaneously:
[Ctrl]+[Alt]+[Del]

Typographic Conventions in Code

Convention Element Example
Caps and
lowercase

Oracle Forms
triggers

When-Validate-Item

Lowercase Column names,
table names

SELECT last_name
FROM s_emp;

Passwords DROP USER scott
IDENTIFIED BY tiger;

PL/SQL objects OG_ACTIVATE_LAYER
(OG_GET_LAYER

(‘prod_pie_layer’))

Lowercase
italic

Syntax variables CREATE ROLE role

Uppercase SQL commands and
functions

SELECT userid
FROM emp;

Typographic Conventions in Navigation Paths

This course uses simplified navigation paths, such as the following example, to
direct you through Oracle Applications.

(N) Invoice > Entry > Invoice Batches Summary (M) Query > Find (B) Approve

This simplified path translates to the following:

1. (N) From the Navigator window, select Invoice > Entry > Invoice Batches
Summary.

2. (M) From the menu, select Query > Find.

3. (B) Click the Approve button.

Notations :

(N) = Navigator

(M) = Menu

(T) = Tab
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(I) = Icon

(H) = Hyperlink

(B) = Button

Typographical Conventions in Help System Paths

This course uses a “navigation path” convention to represent actions you perform
to find pertinent information in the Oracle Applications Help System.

The following help navigation path, for example—

(Help) General Ledger > Journals > Enter Journals

—represents the following sequence of actions:

1. In the navigation frame of the help system window, expand the General
Ledger entry.

2. Under the General Ledger entry, expand Journals.

3. Under Journals, select Enter Journals.

4. Review the Enter Journals topic that appears in the document frame of the
help system window.

Getting Help

Oracle Applications provides you with a complete online help facility.

Whenever you need assistance, simply choose an item from the Help menu to
pinpoint the type of information you want.

To display help for a current window:

1. Choose Window Help from the Help menu, click the Help button on the
toolbar, or hold down the Control key and type 'h'.

A web browser window appears, containing search and navigation frames on
the left, and a frame that displays help documents on the right.

The document frame provides information on the window containing the
cursor. The navigation frame displays the top-level topics for your
responsibility, arranged in a tree control.

2. If the document frame contains a list of topics associated with the window,
click on a topic of interest to display more detailed information.
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3. You can navigate to other topics of interest in the help system, or choose
Close from your web browser's File menu to close help.

Searching for Help

You can perform a search to find the Oracle Applications help information you
want. Simply enter your query in the text field located in the top-left frame of the
browser window when viewing help, then click the adjacent Find button.

A list of titles, ranked by relevance and linked to the documents in question, is
returned from your search in the right-hand document frame. Click on whichever
title seems to best answer your needs to display the complete document in this
frame. If the document doesn't fully answer your questions, use your browser's
Back button to return to the list of titles and try another.
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Notations:
(N) = Navigator
(T) = Tab
(I) = Icon
(H) = Hyperlink
(B) = Button
(Help) = Oracle Applications Help System
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ObjectivesObjectives

After completing this course, you should be able to:
• Describe how to set up suppliers
• Explain the supplier merge process

After completing this course, you should be able to:
• Describe how to set up suppliers
• Explain the supplier merge process
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AgendaAgenda

• Setting up suppliers
• Merging suppliers
• Setting up suppliers
• Merging suppliers
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How Oracle Products Use Supplier
Information

How Oracle Products Use Supplier
Information

Four Oracle financial applications use the Supplier
and Supplier Site windows:
• Oracle Payables
• Oracle Purchasing
• Oracle Assets
• Oracle Property Manager
If you use more than one of these products, supplier
information is shared with the other products.

Four Oracle financial applications use the Supplier
and Supplier Site windows:
• Oracle Payables
• Oracle Purchasing
• Oracle Assets
• Oracle Property Manager
If you use more than one of these products, supplier
information is shared with the other products.

(Help) Oracle Financial Application > Oracle Payables Suppliers >
About Suppliers > How Your Product Uses Supplier Information
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AgendaAgenda

• Setting up suppliers
• Merging suppliers
• Setting up suppliers
• Merging suppliers
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Supplier and Supplier Site SettingsSupplier and Supplier Site Settings
SupplierSupplier

Pay sitePay sitePurchasing sitePurchasing site
RFQ Only siteRFQ Only site

TokyoTokyo New YorkNew York

Purchasing sitePurchasing site
Pay sitePay site

ParisParis
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Supplier and Supplier Site SettingsSupplier and Supplier Site Settings

• For every supplier, you can create an unlimited
number of supplier sites with different addresses
and contacts. For example, for a single supplier,
you can buy from several different sites and send
the payments to only one site.

• You can perform the following functions for a
supplier site when you assign the following types
to the site.
– Pay: You can enter invoices for the site.
– Purchasing: You can create purchase orders

for the site.

• For every supplier, you can create an unlimited
number of supplier sites with different addresses
and contacts. For example, for a single supplier,
you can buy from several different sites and send
the payments to only one site.

• You can perform the following functions for a
supplier site when you assign the following types
to the site.
– Pay: You can enter invoices for the site.
– Purchasing: You can create purchase orders

for the site.

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
About Suppliers > About Suppliers



Copyright © Oracle Corporation, 2000. All rights reserved.

Managing the Supplier Base
Chapter 1 - Page 9

Supplier and Supplier Site Settings

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Supplier and Supplier Site SettingsSupplier and Supplier Site Settings

– RFQ Only: You can create request for
quotations in Oracle Purchasing for the site.
You cannot create purchase orders in an RFQ
Only site.

– Procurement Card: Supplier site that accepts
the credit card brands of your procurement
cards.

• For every supplier site, you can enter contact
information (name, address, and telephone
number) specific to that site. Contact information
is for your reference only. It is not used by the
system for reporting purposes.

– RFQ Only: You can create request for
quotations in Oracle Purchasing for the site.
You cannot create purchase orders in an RFQ
Only site.

– Procurement Card: Supplier site that accepts
the credit card brands of your procurement
cards.

• For every supplier site, you can enter contact
information (name, address, and telephone
number) specific to that site. Contact information
is for your reference only. It is not used by the
system for reporting purposes.
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Supplier and Supplier Site SettingsSupplier and Supplier Site Settings

Supplier and Supplier Site settings can set controls in
your system and help automate transaction entry for
a supplier site. For example, options such as
payment terms, invoice currency, and pay group for a
supplier site default to an invoice when you enter or
import it.
Defaults for many options are set in the following
order and can be overridden at any time:
1. Financials Options
2. Payables Options
3. Supplier
4. Supplier Site

Supplier and Supplier Site settings can set controls in
your system and help automate transaction entry for
a supplier site. For example, options such as
payment terms, invoice currency, and pay group for a
supplier site default to an invoice when you enter or
import it.
Defaults for many options are set in the following
order and can be overridden at any time:
1. Financials Options
2. Payables Options
3. Supplier
4. Supplier Site
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Review QuestionReview Question

You can have only one pay site for a supplier.
1. True
2. False

You can have only one pay site for a supplier.
1. True
2. False



Copyright © Oracle Corporation, 2000. All rights reserved.

Managing the Supplier Base
Chapter 1 - Page 12

Answer to Review Question

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Answer to Review QuestionAnswer to Review Question

You can have only one pay site for a supplier.
1. True
2. False

You can have only one pay site for a supplier.
1. True
2. False
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Avoiding Duplicate SuppliersAvoiding Duplicate Suppliers

Before setting up a new supplier, verify that the
supplier does not already exist in the system by
comparing it to existing suppliers. The verification
eliminates the possibility of having duplicate
suppliers and invoices in the system and improves
the system performance.  To review existing
suppliers:
• Perform a Find or Query on the supplier name.
• Submit the Suppliers Report.
• Submit the Supplier Audit Report to obtain a

listing of suppliers whose names are the same up
to a specific number of characters.

Before setting up a new supplier, verify that the
supplier does not already exist in the system by
comparing it to existing suppliers. The verification
eliminates the possibility of having duplicate
suppliers and invoices in the system and improves
the system performance.  To review existing
suppliers:
• Perform a Find or Query on the supplier name.
• Submit the Suppliers Report.
• Submit the Supplier Audit Report to obtain a

listing of suppliers whose names are the same up
to a specific number of characters.

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Identifying Duplicate Suppliers



Copyright © Oracle Corporation, 2000. All rights reserved.

Managing the Supplier Base
Chapter 1 - Page 14

Avoiding Duplicate Suppliers

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Avoiding Duplicate SuppliersAvoiding Duplicate Suppliers

To avoid entering duplicate suppliers, set up a
naming convention that minimizes the risk of
separate entities for the same supplier under different
names. For example, if you consistently spell the full
name of the supplier, you would not enter both Oracle
Corporation and Oracle Corp.

To avoid entering duplicate suppliers, set up a
naming convention that minimizes the risk of
separate entities for the same supplier under different
names. For example, if you consistently spell the full
name of the supplier, you would not enter both Oracle
Corporation and Oracle Corp.
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Entering Basic Supplier InformationEntering Basic Supplier Information

Enter basic supplier information such as:
• Name
• Taxpayer ID
• Terms
• Supplier Type

Enter basic supplier information such as:
• Name
• Taxpayer ID
• Terms
• Supplier Type

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Suppliers and Supplier Sites Header Field Reference > Suppliers and
Supplier Sites Header Field Reference
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Entering Detailed Supplier InformationEntering Detailed Supplier Information

Enter detailed supplier information such as:
• General
• Classification
• Payment
• Bank Accounts
• Electronic Data Interchange (EDI)
• Invoice Tax
• Withholding Tax
• Tax Reporting

Enter detailed supplier information such as:
• General
• Classification
• Payment
• Bank Accounts
• Electronic Data Interchange (EDI)
• Invoice Tax
• Withholding Tax
• Tax Reporting
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Entering Supplier Information in the
General Region

Entering Supplier Information in the
General Region

The General tabbed region contains additional
reference fields, including:
• Parent Supplier Name
• Number (of the parent supplier)
• Customer Number

The General tabbed region contains additional
reference fields, including:
• Parent Supplier Name
• Number (of the parent supplier)
• Customer Number

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Suppliers and Supplier Sites Window Reference > General Region of
the Suppliers Window
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Entering Supplier Information in the
Classification Region

Entering Supplier Information in the
Classification Region

Except for Type and Employee name, classification
information is not used by the system and is for your
reference only.

Except for Type and Employee name, classification
information is not used by the system and is for your
reference only.

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Suppliers and Supplier Sites Window Reference > Classification
Region of the Suppliers Window
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Entering Supplier Information in the
Control Region

Entering Supplier Information in the
Control Region

In the Control tabbed region, you can prevent
payment of multiple supplier invoices by applying a
hold to the supplier rather than on each individual
invoice. There are several types of supplier related
holds that you can select for a supplier.

In the Control tabbed region, you can prevent
payment of multiple supplier invoices by applying a
hold to the supplier rather than on each individual
invoice. There are several types of supplier related
holds that you can select for a supplier.

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Suppliers and Supplier Sites Window Reference > Control Region of
the Suppliers and Supplier Sites Windows
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Entering Supplier Information in the
Payment Region

Entering Supplier Information in the
Payment Region

The defaults in the Payment tabbed region come from
the information that you enter in the Financials
Options window, except for the defaults for Pay
Group and Allow Interest Invoices, which come from
the Payables Options window.

The defaults in the Payment tabbed region come from
the information that you enter in the Financials
Options window, except for the defaults for Pay
Group and Allow Interest Invoices, which come from
the Payables Options window.

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Suppliers and Supplier Sites Window Reference > Payment Region of
the Suppliers and Supplier Sites Windows
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Entering Supplier Information in the Bank
Accounts Region

Entering Supplier Information in the Bank
Accounts Region

Use the Bank Accounts tabbed region to record
supplier bank account information that you use for
making electronic payment transactions.
Prerequisite: In the Bank Accounts window, define
the bank accounts for which your supplier is the
account holder.

Use the Bank Accounts tabbed region to record
supplier bank account information that you use for
making electronic payment transactions.
Prerequisite: In the Bank Accounts window, define
the bank accounts for which your supplier is the
account holder.

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Suppliers and Supplier Sites Window Reference > Bank Accounts
Region of the Suppliers and Supplier Sites Windows
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Entering Supplier Information in the
Electronic Data Interchange Region
Entering Supplier Information in the
Electronic Data Interchange Region

If you pay your supplier with electronic payments,
enter Electronic Data Interchange (EDI) information
such as:
• EDI Location
• EDI ID Number
• Payment Method
• Payment Format
• Remittance Method
• Remittance Instructions

If you pay your supplier with electronic payments,
enter Electronic Data Interchange (EDI) information
such as:
• EDI Location
• EDI ID Number
• Payment Method
• Payment Format
• Remittance Method
• Remittance Instructions

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Suppliers and Supplier Sites Window Reference > Electronic Data
Interchange Region of the Suppliers and Supplier Sites Windows
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Entering Supplier Information in the
Invoice Tax Region

Entering Supplier Information in the
Invoice Tax Region

The Invoice Tax tabbed region contains the following
tax options:
• Invoice Tax Code
• Use Offset Tax
• Calculation Level
• Allow Calculation Level Override
• Rounding Rule
• Distribution Amounts Include Tax

The Invoice Tax tabbed region contains the following
tax options:
• Invoice Tax Code
• Use Offset Tax
• Calculation Level
• Allow Calculation Level Override
• Rounding Rule
• Distribution Amounts Include Tax

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Suppliers and Supplier Sites Window Reference > Invoice Tax Region
of the Suppliers and Supplier Sites Windows
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Entering Supplier Information in the
Withholding Tax Region

Entering Supplier Information in the
Withholding Tax Region

• Use the Withholding Tax tabbed region to enter
withholding tax information for a supplier and
supplier site.

• You have access to this region only if you selected
the Use Withholding Tax check box in the
Payables Options window.

• The options that you select for a supplier default
to the new supplier sites that you enter, and then
default to invoices that you enter for the site.

• Use the Withholding Tax tabbed region to enter
withholding tax information for a supplier and
supplier site.

• You have access to this region only if you selected
the Use Withholding Tax check box in the
Payables Options window.

• The options that you select for a supplier default
to the new supplier sites that you enter, and then
default to invoices that you enter for the site.

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Suppliers and Supplier Sites Window Reference > Withholding Tax
Region of the Suppliers and Supplier Sites Windows
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Entering Supplier Information in the Tax
Reporting Region

Entering Supplier Information in the Tax
Reporting Region

The Tax Reporting tabbed region contains 1099
information such as whether the supplier is Federal
or State reportable, the Reporting Site, Reporting
Name, and Verification Date.

The Tax Reporting tabbed region contains 1099
information such as whether the supplier is Federal
or State reportable, the Reporting Site, Reporting
Name, and Verification Date.

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Suppliers and Supplier Sites Window Reference > Tax Reporting
Region of the Suppliers Window
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Entering Supplier Information in the
Purchasing Region

Entering Supplier Information in the
Purchasing Region

• All supplier purchasing values default to new
supplier sites that you enter.

• Supplier site values default to purchase orders
and purchase requisitions. You can override any
purchasing defaults during supplier site entry and
purchasing document entry.

• All supplier purchasing values default to new
supplier sites that you enter.

• Supplier site values default to purchase orders
and purchase requisitions. You can override any
purchasing defaults during supplier site entry and
purchasing document entry.

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Suppliers and Supplier Sites Window Reference > Purchasing Region
of the Suppliers and Supplier Sites Windows
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Entering Supplier Information in the
Receiving Region

Entering Supplier Information in the
Receiving Region

All supplier receiving values default to new purchase
orders you enter for a supplier. You can override any
receiving defaults during purchase order entry.

All supplier receiving values default to new purchase
orders you enter for a supplier. You can override any
receiving defaults during purchase order entry.

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Suppliers and Supplier Sites Window Reference > Receiving Region of
the Suppliers and Supplier Sites Windows
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DemonstrationDemonstration

This demonstration covers how to enter supplier
information.

(N) Suppliers > Entry

This demonstration covers how to enter supplier
information.

(N) Suppliers > Entry
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Oracle Payables Supplier Information

General Yes Yes
Classification Yes No
Contacts No Yes
Accounting Yes Yes
Control Yes Yes
Payment Yes Yes
Bank Accounts Yes Yes

Entering Supplier InformationEntering Supplier Information

Information
Type

Enter at 
Supplier

Enter at 
Supplier Site



Copyright © Oracle Corporation, 2000. All rights reserved.

Managing the Supplier Base
Chapter 1 - Page 30

Entering Supplier Information

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Oracle Payables Supplier Information

EDI Yes Yes
Invoice Tax Yes Yes
Withholding Tax Yes Yes
Tax Reporting Yes Yes
Purchasing Yes Yes
Receiving Yes No

Entering Supplier InformationEntering Supplier Information

Information
Type

Enter at 
Supplier

Enter at 
Supplier Site
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Review QuestionReview Question

Which one of the following information types can you
enter at the supplier site only?
1. Bank
2. Contacts
3. Accounting
4. Classification
5. Withholding Tax

Which one of the following information types can you
enter at the supplier site only?
1. Bank
2. Contacts
3. Accounting
4. Classification
5. Withholding Tax
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Answer to Review QuestionAnswer to Review Question

Which one of the following information types can you
enter at the supplier site only?
1. Bank
2. Contacts
3. Accounting
4. Classification
5. Withholding Tax

Which one of the following information types can you
enter at the supplier site only?
1. Bank
2. Contacts
3. Accounting
4. Classification
5. Withholding Tax
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Overview of Entering Information at the
Supplier Site Level

Overview of Entering Information at the
Supplier Site Level

Except for the Receiving and Classification
categories, all categories of information that are
entered at the supplier level can also be entered at
the supplier site level. If an option exists at the
supplier level, the value you enter there defaults to
new supplier sites.
Note: Contacts information is entered only at the
supplier site level.

Except for the Receiving and Classification
categories, all categories of information that are
entered at the supplier level can also be entered at
the supplier site level. If an option exists at the
supplier level, the value you enter there defaults to
new supplier sites.
Note: Contacts information is entered only at the
supplier site level.
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Entering Detailed Supplier Site
Information

Entering Detailed Supplier Site
Information

Enter detailed supplier site information such as:
• Site uses and telephone numbers
• Site addresses

Enter detailed supplier site information such as:
• Site uses and telephone numbers
• Site addresses
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Entering Flexible Address Format
Information

Entering Flexible Address Format
Information

• Oracle applications enable you to enter customer,
supplier, bank, check, and remit-to addresses in
country-specific formats. For example, if you have
customers in the United Kingdom, you can enter
British addresses in the format recommended by
the Royal Mail.

• Use descriptive flexfields to enter and display
address information in the appropriate formats.
The flexfield window is then displayed if the
country you enter has a flexible address style
assigned to it.

• If no address style is associated with the country,
the standard format is used.

• Oracle applications enable you to enter customer,
supplier, bank, check, and remit-to addresses in
country-specific formats. For example, if you have
customers in the United Kingdom, you can enter
British addresses in the format recommended by
the Royal Mail.

• Use descriptive flexfields to enter and display
address information in the appropriate formats.
The flexfield window is then displayed if the
country you enter has a flexible address style
assigned to it.

• If no address style is associated with the country,
the standard format is used.
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Entering Supplier Site Information in the
General Region

Entering Supplier Site Information in the
General Region

In the General tabbed region, select the appropriate
Site Uses check boxes to indicate which specific
business functions are performed at each site, along
with telephone information for that site.

In the General tabbed region, select the appropriate
Site Uses check boxes to indicate which specific
business functions are performed at each site, along
with telephone information for that site.

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Suppliers and Supplier Sites Window Reference > General Region of
the Supplier Sites Window
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Entering Supplier Site Information in the
Contacts Region

Entering Supplier Site Information in the
Contacts Region

In the Contacts tabbed region, enter contact
information specific to that site. Contact information
is for your reference only. It is not used by the system
for reporting purposes.

In the Contacts tabbed region, enter contact
information specific to that site. Contact information
is for your reference only. It is not used by the system
for reporting purposes.

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Suppliers and Supplier Sites Window Reference > Contacts Region of
the Suppliers and Supplier Sites Windows
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Entering Supplier Site Information in the
Accounting Region

Entering Supplier Site Information in the
Accounting Region

In the Accounting tabbed region, enter default GL
accounts for the liability account number, the
prepayment account number, and the future dated
payment account number. You can also enter a
default distribution set for all invoices entered for the
supplier site.

In the Accounting tabbed region, enter default GL
accounts for the liability account number, the
prepayment account number, and the future dated
payment account number. You can also enter a
default distribution set for all invoices entered for the
supplier site.

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Suppliers and Supplier Sites Window Reference > Accounting Region
of the Suppliers and Supplier Sites Windows
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Entering Employees as SuppliersEntering Employees as Suppliers

You must enter an employee as a supplier before you
can pay the employee’s expense reports. You can
enable the Automatically Create Employee as
Supplier Payables option to automatically enter an
employee as a supplier during Invoice Import, or you
can enter the employee manually as a supplier in the
Suppliers window.

You must enter an employee as a supplier before you
can pay the employee’s expense reports. You can
enable the Automatically Create Employee as
Supplier Payables option to automatically enter an
employee as a supplier during Invoice Import, or you
can enter the employee manually as a supplier in the
Suppliers window.

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
About Suppliers > Entering Employees as Suppliers
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DemonstrationDemonstration

This demonstration covers how to enter supplier
site information.

(N) Suppliers > Entry (B) Sites

This demonstration covers how to enter supplier
site information.

(N) Suppliers > Entry (B) Sites
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Practice 1 OverviewPractice 1 Overview

This practice covers the following topics:
• Entering supplier information
• Entering supplier site information

This practice covers the following topics:
• Entering supplier information
• Entering supplier site information
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Practice 1 InstructionsPractice 1 Instructions

Your supervisor has notified you that the company
will be purchasing materials and services from two
new suppliers. Supplier #1 provides materials and
Supplier #2 provides services.
Supplier #1
• Name: You decide
• Type: Manufacturing
• Payment Terms: Immediate
• Site: Your hometown and a fictional address
• Site Uses: Pay and Purchasing site
• Contact: Yourself

Your supervisor has notified you that the company
will be purchasing materials and services from two
new suppliers. Supplier #1 provides materials and
Supplier #2 provides services.
Supplier #1
• Name: You decide
• Type: Manufacturing
• Payment Terms: Immediate
• Site: Your hometown and a fictional address
• Site Uses: Pay and Purchasing site
• Contact: Yourself

Practice 1 Solutions
1. Navigate to the Suppliers window.
(N) Suppliers >Entry
2. Enter your supplier name.
3. In the Classification tabbed region, enter the supplier type.
4. In the Payments tabbed region, enter the payment terms for your supplier.
5. Navigate to the Supplier Sites window.
(B) Sites
6. Enter your supplier site name and address.
7. In the Contacts tabbed region, enter the contact information.
8. Save your work.
9. Repeat the above steps to create the second supplier.
10. To set the invoice limit amount for supplier #2, in the Control tabbed region
of the Suppliers window, enter the limit amount.
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Practice 1 InstructionsPractice 1 Instructions

• Terms Date Basis: Invoice
Supplier #2
• Name: You decide
• Type: Supplier Invoice Amount Limit: $15,000
• Payment Terms: Immediate
• Site: Your favorite vacation spot
• Site Uses: Pay and Purchasing site
• Contact: Your favorite person
• Site 2: You decide and enter contact information
• Terms Date Basis: Invoice

• Terms Date Basis: Invoice
Supplier #2
• Name: You decide
• Type: Supplier Invoice Amount Limit: $15,000
• Payment Terms: Immediate
• Site: Your favorite vacation spot
• Site Uses: Pay and Purchasing site
• Contact: Your favorite person
• Site 2: You decide and enter contact information
• Terms Date Basis: Invoice
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Searching and Reviewing Supplier Information Online
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Searching and Reviewing Supplier
Information Online

Searching and Reviewing Supplier
Information Online

You can find suppliers by using the Find Suppliers
window or by entering a query directly into the
Suppliers window.
In the Find Suppliers window, you can enter a variety
of search criteria, including tax status, parent
supplier, and payment priority range. You can use the
Find feature to initiate a query for one supplier or for
a group of suppliers.

You can find suppliers by using the Find Suppliers
window or by entering a query directly into the
Suppliers window.
In the Find Suppliers window, you can enter a variety
of search criteria, including tax status, parent
supplier, and payment priority range. You can use the
Find feature to initiate a query for one supplier or for
a group of suppliers.

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Reviewing and Adjusting Suppliers
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Maintaining Supplier and Supplier Site Information
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Maintaining Supplier and Supplier Site
Information

Maintaining Supplier and Supplier Site
Information

When you make changes to values that default to
Oracle Payables documents, the changed value
defaults only to new documents that you
subsequently enter or create. For example, if you
change the Pay Group for a supplier site, the new Pay
Group defaults to new invoices that you enter, but the
change does not affect existing invoices.
Also, if you change a supplier value that defaults to
supplier sites, the change affects only new supplier
sites that you create, not existing supplier sites.
If you want a change to affect documents that you
enter or create for an existing supplier site, be sure to
make the changes at the supplier site level.

When you make changes to values that default to
Oracle Payables documents, the changed value
defaults only to new documents that you
subsequently enter or create. For example, if you
change the Pay Group for a supplier site, the new Pay
Group defaults to new invoices that you enter, but the
change does not affect existing invoices.
Also, if you change a supplier value that defaults to
supplier sites, the change affects only new supplier
sites that you create, not existing supplier sites.
If you want a change to affect documents that you
enter or create for an existing supplier site, be sure to
make the changes at the supplier site level.

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Adjusting Suppliers
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Supplier Reports
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Supplier ReportsSupplier Reports
Oracle Payables Supplier Reports

Report Name Description
Suppliers Report Review supplier, supplier site, and

supplier site contacts information
Supplier Audit Report Review supplier names that

are similar, to help identify potential
duplicate suppliers

New Supplier/New Review new supplier sites
Supplier Site Listing

Supplier Payment Review the payment history,
History including void payments, for a 

supplier or a group of suppliers
Supplier Paid Review the payment history,
Invoice History including discount and partial 

payment information, for a supplier
or group of suppliers

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Supplier Reports
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Supplier Reports
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Supplier ReportsSupplier Reports
Oracle Payables Supplier Reports

Report Name Description
Supplier Mailing Use this report to create mailing
Labels labels for supplier sites
Purchase Order Header Review purchase orders updated
Updates Report by the Supplier Merge Program
Supplier Merge Report Review the suppliers, sites, and 

invoices updated by the Supplier 
Merge Process

Supplier Balance Identify suppliers with credit
Revaluation Report (negative) balances

Supplier Customer Review the net balance in Oracle 
Netting Report Payables and Oracle Receivables

for any suppliers or customers who
have the same NIF or VAT code
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Practice 2 Overview

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Practice 2 OverviewPractice 2 Overview

This practice covers the following topics:
• Searching for suppliers
• Reviewing and updating supplier and supplier site

information
• Submitting the New Supplier/New Supplier Listing

Report

This practice covers the following topics:
• Searching for suppliers
• Reviewing and updating supplier and supplier site

information
• Submitting the New Supplier/New Supplier Listing

Report
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Practice 2 Instructions
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Practice 2 InstructionsPractice 2 Instructions

You want to review and change some supplier and
supplier site information for the two new suppliers
that you just created.
• Find your first supplier and add a second site.
• Find your second supplier and make the second

supplier site inactive.
• Submit the New Supplier/New Supplier Listing

Report.

You want to review and change some supplier and
supplier site information for the two new suppliers
that you just created.
• Find your first supplier and add a second site.
• Find your second supplier and make the second

supplier site inactive.
• Submit the New Supplier/New Supplier Listing

Report.

Practice 2 Solutions
Step 1: Search for the first supplier and add a new site
1. Navigate to the Suppliers window.
(N) Suppliers >Entry
2. Click on the Find icon from the Toolbar or select Find from the View menu.
3. Enter the search criteria for the supplier name that you previously entered.
4. Select the Find button in the Find Suppliers window.
5. To add a new site, navigate to the Supplier Sites window.
(B) Sites
6. Insert a new record by selecting the New icon.
7. Enter your new supplier site name and address.
8. In the Contacts region, enter the contact information.
9. Save your work.
10. Review the information in the other tabbed regions of the Supplier Sites
window.
Step 2: Search for the second supplier and inactivate the second site
1. Remain in the Suppliers window.
2. Click on the Find icon from the Toolbar or select Find from the View menu.
3. Enter the search criteria for the second supplier that you previously entered.
4. Select the Find button in the Find Suppliers window.
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5. Select the Sites button. Oracle Payables opens the Supplier Sites window.
6. Choose the second site.
7. In the Inactivate On field, enter today’s date.
8. Save your work.
Step 3: Submit the New Supplier/New Supplier Site Listing report
1. Navigate to the Submit Request window.
(N) Other > Requests > Run > (B) Single Request (B) OK
2. In the Name field, enter New Supplier/New Supplier Site Listing.
3. In the Parameters window, enter:
•  Start Date: Today’s date
•  List Suppliers or Sites?: New Suppliers
•  Order By: Supplier Name
• 4. Click OK.
• 5. Choose Submit. Note your Request ID ______________.
• 6. Review the report by navigating to the Requests window.
• (N) Other > Requests > View
• 7. Select the Specific Requests button.
• 8. Enter your request ID in the Request ID field.
• 9. Choose the Find button.
• 10. Once the report is completed, select the View Output button to see the report.



Copyright © Oracle Corporation, 2000. All rights reserved.

Managing the Supplier Base
Chapter 1 - Page 51

Review Question
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Review QuestionReview Question

Which one of the following reports would you use to
review suppliers, supplier sites, and supplier site
contacts information?
1. Suppliers Report
2. Supplier Audit Report
3. Supplier Merge Report
4. Supplier Customer Netting Report
5. New Supplier/New Supplier Site Listing

Which one of the following reports would you use to
review suppliers, supplier sites, and supplier site
contacts information?
1. Suppliers Report
2. Supplier Audit Report
3. Supplier Merge Report
4. Supplier Customer Netting Report
5. New Supplier/New Supplier Site Listing
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Answer to Review Question
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Answer to Review QuestionAnswer to Review Question

Which one of the following reports would you use to
review suppliers, supplier sites, and supplier site
contacts information?
1. Suppliers Report
2. Supplier Audit Report
3. Supplier Merge Report
4. Supplier Customer Netting Report
5. New Supplier/New Supplier Site Listing

Which one of the following reports would you use to
review suppliers, supplier sites, and supplier site
contacts information?
1. Suppliers Report
2. Supplier Audit Report
3. Supplier Merge Report
4. Supplier Customer Netting Report
5. New Supplier/New Supplier Site Listing



Copyright © Oracle Corporation, 2000. All rights reserved.

Managing the Supplier Base
Chapter 1 - Page 53

Agenda
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AgendaAgenda

• Setting up suppliers
• Merging suppliers
• Setting up suppliers
• Merging suppliers
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Merging Suppliers
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Merging SuppliersMerging Suppliers

Run supplierRun supplier
audit reportaudit report

ABCABC
CorpCorp

ABCABC
CorporationCorporation

Review mergeReview merge
resultsresults

ABCABC
CorporationCorporation

Merge suppliersMerge suppliers

Identify duplicateIdentify duplicate
supplierssuppliers

Maintain auditMaintain audit
trailtrail
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Overview of Merging Suppliers
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Overview of Merging SuppliersOverview of Merging Suppliers

Although the system prevents you from entering
duplicate supplier names, you may inadvertently
define the same supplier by using two different
names. For example, you might enter ABC
Corporation and ABC Corp, or you might enter a
contractor under his name and his company name.
You might also create duplicate suppliers if you
import suppliers from another accounts payable
system.

Although the system prevents you from entering
duplicate supplier names, you may inadvertently
define the same supplier by using two different
names. For example, you might enter ABC
Corporation and ABC Corp, or you might enter a
contractor under his name and his company name.
You might also create duplicate suppliers if you
import suppliers from another accounts payable
system.
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Overview of Merging Suppliers
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Overview of Merging SuppliersOverview of Merging Suppliers

Use Supplier Merge to combine two or more suppliers
that you identify as duplicates. You can update
purchase orders and invoices for the old supplier to
refer to the new supplier. The Supplier Merge window
also enables you to merge supplier sites so that any
sites assigned to an old supplier can be reassigned
to the new supplier.

Use Supplier Merge to combine two or more suppliers
that you identify as duplicates. You can update
purchase orders and invoices for the old supplier to
refer to the new supplier. The Supplier Merge window
also enables you to merge supplier sites so that any
sites assigned to an old supplier can be reassigned
to the new supplier.
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Merging Suppliers
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Merging SuppliersMerging Suppliers

When you merge suppliers, you transfer invoices,
purchase orders, or both from one supplier and site
to another supplier and site. You can transfer to a
new supplier and site unpaid invoices only or all
invoices (including paid and partially paid invoices).
Oracle Payables will not transfer invoices if the merge
process would create a duplicate invoice for a
supplier.
Note: The merge process cannot be undone.

When you merge suppliers, you transfer invoices,
purchase orders, or both from one supplier and site
to another supplier and site. You can transfer to a
new supplier and site unpaid invoices only or all
invoices (including paid and partially paid invoices).
Oracle Payables will not transfer invoices if the merge
process would create a duplicate invoice for a
supplier.
Note: The merge process cannot be undone.

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Supplier Merge Program
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Merging Suppliers
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Merging SuppliersMerging Suppliers

For best auditing results, transfer both paid and
unpaid invoices to a new supplier and site so you can
identify duplicate payments easily. Also, transfer both
purchase orders and invoices to a new supplier and
site so all invoice and purchase order information
refers to the same supplier.

For best auditing results, transfer both paid and
unpaid invoices to a new supplier and site so you can
identify duplicate payments easily. Also, transfer both
purchase orders and invoices to a new supplier and
site so all invoice and purchase order information
refers to the same supplier.
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Merging Suppliers
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Merging SuppliersMerging Suppliers

After you have merged suppliers, Oracle Payables
automatically prints the Purchase Order Header
Updates Report and the Supplier Merge Report as an
audit trail of your supplier merge activity. The
Supplier Merge Report also lists any duplicate
invoices that it did not merge. Research the
duplicated invoice. You can then update the invoice
number if the invoice has not been paid or accounted.

After you have merged suppliers, Oracle Payables
automatically prints the Purchase Order Header
Updates Report and the Supplier Merge Report as an
audit trail of your supplier merge activity. The
Supplier Merge Report also lists any duplicate
invoices that it did not merge. Research the
duplicated invoice. You can then update the invoice
number if the invoice has not been paid or accounted.
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Demonstration
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DemonstrationDemonstration

This demonstration covers how to merge supplier
information.

(N) Suppliers > Supplier Merge

This demonstration covers how to merge supplier
information.

(N) Suppliers > Supplier Merge
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Identifying Duplicate Suppliers
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Identifying Duplicate SuppliersIdentifying Duplicate Suppliers

• Review supplier records periodically to achieve
the following:
– Prevent duplicate invoices
– Improve system performance
– Provide accurate supplier reporting

• Use the Suppliers Report and the Supplier Audit
Report to help identify duplicate suppliers.

• Review supplier records periodically to achieve
the following:
– Prevent duplicate invoices
– Improve system performance
– Provide accurate supplier reporting

• Use the Suppliers Report and the Supplier Audit
Report to help identify duplicate suppliers.
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Maintaining Reports As an Audit Trail
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Maintaining Reports As an Audit TrailMaintaining Reports As an Audit Trail

• Oracle Payables does not maintain an online audit
trail for merged supplier records.

• To review merged records, Oracle Payables
automatically prints the Purchase Order Header
Updates Report and Supplier Merge Report.

• Keep these reports as an audit trail.

• Oracle Payables does not maintain an online audit
trail for merged supplier records.

• To review merged records, Oracle Payables
automatically prints the Purchase Order Header
Updates Report and Supplier Merge Report.

• Keep these reports as an audit trail.

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Supplier Merge Report
(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
Purchase Order Header Updates Report



Copyright © Oracle Corporation, 2000. All rights reserved.

Managing the Supplier Base
Chapter 1 - Page 63

Review Question

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Review QuestionReview Question

In the Supplier Merge window, you can merge both
suppliers and supplier sites.
1. True
2. False

In the Supplier Merge window, you can merge both
suppliers and supplier sites.
1. True
2. False
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Answer to Review QuestionAnswer to Review Question

In the Supplier Merge window, you can merge both
suppliers and supplier sites.
1. True
2. False

In the Supplier Merge window, you can merge both
suppliers and supplier sites.
1. True
2. False
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Summary
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SummarySummary

In this lesson, you should have learned how to:
• Set up suppliers
• Explain the merge suppliers process

In this lesson, you should have learned how to:
• Set up suppliers
• Explain the merge suppliers process
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R11i Overview of Supplier
Invoicing
Chapter 2
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R11i Overview of Supplier Invoicing
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R11i Overview of Supplier InvoicingR11i Overview of Supplier Invoicing

Oracle Payables Release 11iOracle Payables Release 11i
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Course Objectives
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Course ObjectivesCourse Objectives

After completing this module, you should be able to
do the following:
• Describe the supplier invoicing process
• Explain the key concepts of invoice processing

After completing this module, you should be able to
do the following:
• Describe the supplier invoicing process
• Explain the key concepts of invoice processing
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Course Agenda
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Course AgendaCourse Agenda

• Product integration
• Overview of Oracle Payables
• Flow of default values
• Suppliers
• Overview of invoice entry process

• Product integration
• Overview of Oracle Payables
• Flow of default values
• Suppliers
• Overview of invoice entry process
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Product Integration
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Product IntegrationProduct Integration

OracleOracle
AssetsAssets

Oracle ProjectsOracle Projects

OracleOracle
General LedgerGeneral Ledger

Oracle HumanOracle Human
ResourcesResources

Oracle CashOracle Cash
ManagementManagement

OracleOracle
PurchasingPurchasing

Oracle PayablesOracle Payables

OracleOracle
WorkflowWorkflow

OracleOracle
e-Commercee-Commerce

GatewayGateway

OracleOracle
PropertyProperty
ManagerManager

OracleOracle
iiExpensesExpenses
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Oracle Payables Integration
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Oracle Payables IntegrationOracle Payables Integration

• Oracle Human Resources shares locations and
employees with Oracle Payables.

• Oracle Projects imports invoice information from
Payables to track project costs and exports
expense report information to Oracle Payables.

• Oracle Cash Management reconciles payments
created in Oracle Payables to your bank
statements.

• Oracle e-Commerce Gateway transfers electronic
invoices and EDI payments to Oracle Payables.

• Oracle Human Resources shares locations and
employees with Oracle Payables.

• Oracle Projects imports invoice information from
Payables to track project costs and exports
expense report information to Oracle Payables.

• Oracle Cash Management reconciles payments
created in Oracle Payables to your bank
statements.

• Oracle e-Commerce Gateway transfers electronic
invoices and EDI payments to Oracle Payables.
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Oracle Payables Integration
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Oracle Payables IntegrationOracle Payables Integration

• Oracle Property Manager exports lease payment
information to Oracle Payables where you can pay
the lease invoices.

• Oracle iExpenses can be used by employees to
enter their own expense reports.

• Oracle Workflow can be set up to process invoice
records before you import them from the Payables
Open Interface.

• Oracle General Ledger and other general ledger
systems receive invoice and payment accounting
entries from Oracle Payables.

• Oracle Property Manager exports lease payment
information to Oracle Payables where you can pay
the lease invoices.

• Oracle iExpenses can be used by employees to
enter their own expense reports.

• Oracle Workflow can be set up to process invoice
records before you import them from the Payables
Open Interface.

• Oracle General Ledger and other general ledger
systems receive invoice and payment accounting
entries from Oracle Payables.
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Oracle Payables Integration
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Oracle Payables IntegrationOracle Payables Integration

• Oracle Assets and other fixed assets systems
record Payables invoice distributions for asset
purchases.

• Oracle Purchasing and other purchasing systems
share purchase orders and suppliers with
Payables.

• Oracle Assets and other fixed assets systems
record Payables invoice distributions for asset
purchases.

• Oracle Purchasing and other purchasing systems
share purchase orders and suppliers with
Payables.
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Overview of Oracle Payables
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Overview of Oracle PayablesOverview of Oracle Payables

• Oracle Payables is a high-productivity accounting
solution that helps you maintain strong financial
controls. You can:
– Maximize supplier discounts
– Prevent duplicate payments
– Pay for only the goods and services that you

order and receive
• Oracle Payables also helps you resolve business

issues quickly by providing accurate responses to
your inquiries.

• Oracle Payables is a high-productivity accounting
solution that helps you maintain strong financial
controls. You can:
– Maximize supplier discounts
– Prevent duplicate payments
– Pay for only the goods and services that you

order and receive
• Oracle Payables also helps you resolve business

issues quickly by providing accurate responses to
your inquiries.
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Five Major Processes
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Five Major ProcessesFive Major Processes

Oracle Payables contains five major processes:
 1. Setting up suppliers
 2. Entering and approving invoices
 3. Paying invoices
 4. Creating accounting entries
 5. Sending transactions to the general ledger

Oracle Payables contains five major processes:
 1. Setting up suppliers
 2. Entering and approving invoices
 3. Paying invoices
 4. Creating accounting entries
 5. Sending transactions to the general ledger
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 Oracle Payables Processes Oracle Payables Processes
    Enter supplierEnter supplier Enter invoiceEnter invoice Approve invoiceApprove invoice

  Create accounting  Create accounting
entriesentries

  Transfer information  Transfer information
to general ledgerto general ledger

Pay invoicePay invoice

100,000100,000

A/P A/P 

60,00060,000
10,00010,000
30,00030,000



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Overview of Supplier Invoicing
Chapter 2 - Page 12

Flow of Default Values
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Flow of Default ValuesFlow of Default Values
Financials options

Payables options

Supplier

Supplier site

Invoice

Invoice distribution line Invoice scheduled payment line
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Review Question
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If a default is set at the Payables-options level in the
hierarchy, you can override the default at the Supplier
level.
A. True
B. False

If a default is set at the Payables-options level in the
hierarchy, you can override the default at the Supplier
level.
A. True
B. False

Review QuestionReview Question
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If a default is set at the Payables-options level in the
hierarchy, you can override the default at the Supplier
level.
A. True
B. False

If a default is set at the Payables-options level in the
hierarchy, you can override the default at the Supplier
level.
A. True
B. False

Answer to Review QuestionAnswer to Review Question
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Suppliers: Overview
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 Suppliers: Overview Suppliers: Overview
    Enter supplierEnter supplier Enter invoiceEnter invoice Approve invoiceApprove invoice

  Create accounting  Create accounting
entriesentries

  Transfer information  Transfer information
to general ledgerto general ledger

Pay invoicePay invoice

100,000100,000

A/PA/P

60,00060,000
10,00010,000
30,00030,000
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How Oracle Products Use  Supplier Information
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How Oracle Products Use
Supplier Information

How Oracle Products Use
Supplier Information

• Four Oracle financial applications use the Supplier
windows:
– Oracle Payables
– Oracle Purchasing
– Oracle Assets
– Oracle Property Manager

• If you use more than one of these products,
supplier information is shared with the other
products.

• Four Oracle financial applications use the Supplier
windows:
– Oracle Payables
– Oracle Purchasing
– Oracle Assets
– Oracle Property Manager

• If you use more than one of these products,
supplier information is shared with the other
products.

(Help) Oracle Financial Applications > Oracle Payables > Suppliers >
About Suppliers > How Your Oracle Product Uses Supplier
Information
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 Entering Invoices: Overview Entering Invoices: Overview
    Enter supplierEnter supplier Enter invoicesEnter invoices

Approve invoicesApprove invoices

  Create accounting  Create accounting
entriesentries

  Transfer information  Transfer information
to general ledgerto general ledger

Pay invoicesPay invoices
OptionallyOptionally

match to PO ormatch to PO or
receiptreceipt

100,000100,000

A/PA/P

60,00060,000
10,00010,000
30,00030,000
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Entering Invoices
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Entering InvoicesEntering Invoices

You can enter invoices into Oracle Payables using
the

following methods:
• Enter individual invoices in the Invoices window
• Enter invoices in batches in the Invoice Batches

and the Invoices window
• Enter standard and credit memo invoices that are

not complex in the Invoice Gateway window
• Assign invoices to an invoice batch in the Invoice

Gateway window
• Create recurring invoices in the Recurring Invoices

window

You can enter invoices into Oracle Payables using
the

following methods:
• Enter individual invoices in the Invoices window
• Enter invoices in batches in the Invoice Batches

and the Invoices window
• Enter standard and credit memo invoices that are

not complex in the Invoice Gateway window
• Assign invoices to an invoice batch in the Invoice

Gateway window
• Create recurring invoices in the Recurring Invoices

window

(Help) Oracle Financial Applications > Oracle Payables > Invoices >
Entering Invoices Overview
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Entering Invoices

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Entering InvoicesEntering Invoices

You can enter invoices into Oracle Payables using
the

following methods:
• Create invoices from expense reports or import

invoices from other systems (e-Commerce
Gateway, Property Manager, Self-Service
Expenses, and flat files)

• Create invoices to pay interest for overdue
invoices

You can enter invoices into Oracle Payables using
the

following methods:
• Create invoices from expense reports or import

invoices from other systems (e-Commerce
Gateway, Property Manager, Self-Service
Expenses, and flat files)

• Create invoices to pay interest for overdue
invoices
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Using the Workbench Model
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Using the Workbench ModelUsing the Workbench Model

• Oracle Payables includes two fully integrated
workbenches:
– Invoice Workbench
– Payment Workbench

• You can enter, adjust, or review invoices in the
Invoice Workbench.

• Oracle Payables includes two fully integrated
workbenches:
– Invoice Workbench
– Payment Workbench

• You can enter, adjust, or review invoices in the
Invoice Workbench.

(Help) Oracle Financial Applications > Oracle Payables > Overview >
The Invoice Workbench
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Using the Invoice Workbench
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Using the Invoice WorkbenchUsing the Invoice Workbench

Invoice batches Invoices Distributions

Find Find Find

Invoice
overview
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The Invoice Workbench: Invoice Batches
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The Invoice Workbench: Invoice BatchesThe Invoice Workbench: Invoice Batches

Invoice Batches
Find Invoice Batches

Invoice Batches
Find Invoice Batches
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The Invoice Workbench: Invoices
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The Invoice Workbench: InvoicesThe Invoice Workbench: Invoices

Invoices
• Find Invoices

Calculate Balance Owed
• Find Purchase Orders for Matching

Match to Purchase Order
• Find Receipts for Matching

– Match to Receipts
– Match Other Charges to Receipts

Invoices
• Find Invoices

Calculate Balance Owed
• Find Purchase Orders for Matching

Match to Purchase Order
• Find Receipts for Matching

– Match to Receipts
– Match Other Charges to Receipts
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The Invoice Workbench: Invoices
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The Invoice Workbench: InvoicesThe Invoice Workbench: Invoices

• Find Invoices for Matching
Match to Invoices

• Invoice Actions
Apply/Unapply Prepayments

• View Invoice Accounting
• Invoice Holds

Release
• View Projected Withholding
• Match Other Charges to Receipts

• Find Invoices for Matching
Match to Invoices

• Invoice Actions
Apply/Unapply Prepayments

• View Invoice Accounting
• Invoice Holds

Release
• View Projected Withholding
• Match Other Charges to Receipts
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The Invoice Workbench: Distributions
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The Invoice Workbench: DistributionsThe Invoice Workbench: Distributions

Distributions
• Find Invoice
• Charge Allocations
• Tax Summary
• View Encumbrances
• View Receipts
• View PO

Distributions
• Find Invoice
• Charge Allocations
• Tax Summary
• View Encumbrances
• View Receipts
• View PO
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Demonstration
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DemonstrationDemonstration

This demonstration covers the Invoice Workbench.

(N) Invoices—>Entry—>Invoices

This demonstration covers the Invoice Workbench.

(N) Invoices—>Entry—>Invoices
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Review Question
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Review QuestionReview Question

Which of the following tasks can you perform in the
Invoice Workbench?
A. Enter an invoice
B. Modify an invoice
C. Approve an invoice
D. Modify invoice distributions
E. All of the above

Which of the following tasks can you perform in the
Invoice Workbench?
A. Enter an invoice
B. Modify an invoice
C. Approve an invoice
D. Modify invoice distributions
E. All of the above
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Answer to Review Question

Copyright  Oracle Corporation, 2000. All rights reserved.
®

E. All of the aboveE. All of the above

Which of the following tasks can you perform in the
Invoice Workbench?
A. Enter an invoice
B. Modify an invoice
C. Approve an invoice
D. Modify invoice distributions

Which of the following tasks can you perform in the
Invoice Workbench?
A. Enter an invoice
B. Modify an invoice
C. Approve an invoice
D. Modify invoice distributions

Answer to Review QuestionAnswer to Review Question
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Oracle Payables Invoice Types
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Type Description
Standard An invoice from a supplier representing an

amount due for goods or services purchased
(standard invoices can be matched to either a
PO or receipt, or not matched)

Credit Memo A memo from a supplier representing a credit
amount toward goods or services for which you
have already been invoiced

Debit Memo An invoice you enter to record a credit for a
supplier who does not send you a credit memo

Expense An invoice representing an amount due to an
Report employee for business-related expenses
PO Default An invoice you enter for matching to a purchase

order (you enter a PO number, and Oracle
Payables automatically provides supplier
information)

Oracle Payables Invoice TypesOracle Payables Invoice Types
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Oracle Payables Invoice Types
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Type Description
Prepayment A type of invoice you enter to pay an advance

payment for expenses to a supplier
or employee

QuickMatch An invoice you enter for matching to a purchase
order (you enter a PO number, and Oracle
Payables automatically provides supplier 
information and matches to each shipment on
the purchase order)

Withholding An invoice you enter to remit taxes withheld to
Tax the appropriate tax authority
Mixed An invoice for which you can perform both

positive and negative matching to
purchase orders and to other invoices

Oracle Payables Invoice TypesOracle Payables Invoice Types
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Demonstration
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DemonstrationDemonstration

This demonstration covers how to enter an invoice in
the Invoice Gateway window.

(N) Invoices—>Entry—>Invoice Gateway

This demonstration covers how to enter an invoice in
the Invoice Gateway window.

(N) Invoices—>Entry—>Invoice Gateway
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Interest Invoices
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Interest InvoicesInterest Invoices

Payables can automatically create invoices to pay
interest for overdue invoices if:
• You enable automatic interest calculation for a

supplier
• You pay an overdue invoice for the supplier in a

payment batch or with a Quick payment

Payables can automatically create invoices to pay
interest for overdue invoices if:
• You enable automatic interest calculation for a

supplier
• You pay an overdue invoice for the supplier in a

payment batch or with a Quick payment

(Help) Oracle Financial Applications > Oracle Payables > Other
Topics > Automatic Interest/Prompt Payment Support
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Invoice Distribution Types
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Type Description

Item Records the amount a supplier charges for
goods or services purchased

Tax Records the sales or other tax amount due
on goods or services purchased

Freight Records the amount a supplier charges for
shipping and handling

Miscellaneous Records the amount for miscellaneous 
expenses on an invoice

Invoice Distribution TypesInvoice Distribution Types
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Invoice Distribution Types
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Type Description

Withholding Records the amount of taxes withheld from
an invoice

Prepayment Records the amount of a prepayment
applied to an invoice

Invoice Distribution TypesInvoice Distribution Types
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Other Invoice Distributions
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 Other Invoice Distributions Other Invoice Distributions

You can also create distributions by:
• Matching to purchase orders and receipts
• Using distribution sets
• Allocating freight, tax, and miscellaneous lines

You can also create distributions by:
• Matching to purchase orders and receipts
• Using distribution sets
• Allocating freight, tax, and miscellaneous lines

(Help) Oracle Financial Applications > Oracle Payables > Invoices >
Invoice Workbench > Entering Distributions in the Invoice
Workbench
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Allocating Freight, Tax,  and Miscellaneous Lines
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Allocating Freight, Tax,
and Miscellaneous Lines
Allocating Freight, Tax,

and Miscellaneous Lines

TaxTax

FreightFreight MiscellaneousMiscellaneous

ItemItem

Prepayment linePrepayment line

(Help) Oracle Financial Applications > Oracle Payables > Invoices >
Allocation > Allocation Overview  > Creating Distributions by
Allocation
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Review Question
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Review QuestionReview Question

You can allocate a freight line to which of the
following lines?
A. Tax
B. Item
C. Prepayment
D. Miscellaneous
E. All of the above

You can allocate a freight line to which of the
following lines?
A. Tax
B. Item
C. Prepayment
D. Miscellaneous
E. All of the above
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Answer to Review Question
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You can allocate a freight line to which of the
following lines?
A. Tax

C. Prepayment
D. Miscellaneous
E. All of the above

You can allocate a freight line to which of the
following lines?
A. Tax

C. Prepayment
D. Miscellaneous
E. All of the above

Answer to Review QuestionAnswer to Review Question

B. ItemB. Item
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Invoice Inquiry: Overview
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Invoice Inquiry: OverviewInvoice Inquiry: Overview

Batch invoicesBatch invoices Enter invoiceEnter invoice

Approve invoice

OptionallyOptionally
match to POmatch to PO

or receiptor receipt

File invoiceFile invoice

CreateCreate
accountingaccounting

View invoiceView invoice

Pay invoicePay invoice

Receive invoicesReceive invoices
in the mailin the mail

100,000100,000

A/PA/P

60,00060,000
10,00010,000
30,00030,000

Approve invoiceApprove invoice
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Demonstration

Copyright  Oracle Corporation, 2000. All rights reserved.
®

DemonstrationDemonstration

This demonstration covers how to view high-level
invoice information.

(N) Invoices—>Inquiry—>Invoice Overview

This demonstration covers how to view high-level
invoice information.

(N) Invoices—>Inquiry—>Invoice Overview
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Approving Invoices: Overview
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Approving Invoices: OverviewApproving Invoices: Overview

Batch invoicesBatch invoices Enter invoiceEnter invoice

Approve invoice

OptionallyOptionally
match to POmatch to PO

or receiptor receipt

File invoiceFile invoice

CreateCreate
accountingaccounting

View invoiceView invoice

Pay invoicePay invoice

Receive invoicesReceive invoices
in the mailin the mail

100,000100,000

A/PA/P

60,00060,000
10,00010,000
30,00030,000
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Approving Invoices
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Approving InvoicesApproving Invoices

Before you can pay or account for an invoice
(including prepayments), you must submit approval
for the invoice in one of three ways:
• Online by using the Actions window of the Invoice

Workbench
• Online by using the Approve button in the Invoice

Batches window
• Batch by submitting the Payables Approval

program from the Submit Request window

Before you can pay or account for an invoice
(including prepayments), you must submit approval
for the invoice in one of three ways:
• Online by using the Actions window of the Invoice

Workbench
• Online by using the Approve button in the Invoice

Batches window
• Batch by submitting the Payables Approval

program from the Submit Request window

(Help) Oracle Financial Applications > Oracle Payables > Invoices >
Approval > Approval
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Approving Invoices
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Approving InvoicesApproving Invoices

You can also approve related invoices for credit and
debit memos by choosing Approve Related Invoices
in the Actions window after you enter a credit or debit
memo.

You can also approve related invoices for credit and
debit memos by choosing Approve Related Invoices
in the Actions window after you enter a credit or debit
memo.
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Approving Invoices
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Approving InvoicesApproving Invoices

• Approval validates the matching, tax, period
status, exchange rate, and distribution information
for invoices that you enter and automatically
applies holds to exception invoices.

• If a tax distribution is not allocated or not fully
allocated, Approval fully allocates the tax
distribution by prorating across all taxable
distributions.

• Approval validates the matching, tax, period
status, exchange rate, and distribution information
for invoices that you enter and automatically
applies holds to exception invoices.

• If a tax distribution is not allocated or not fully
allocated, Approval fully allocates the tax
distribution by prorating across all taxable
distributions.
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Accounting for Invoices
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Accounting for InvoicesAccounting for Invoices

• You submit the Payables Accounting process to
create accounting entries in Payables. Submit this
batch process from the Submit Request window.

• You can also create accounting entries for an
invoice from the related Actions window.
– Select the invoice.
– Click the Actions button.
– Select the Create Accounting check box, and

click OK.
• To account for an invoice batch, query the batch in

the Invoice Batches window, and then click the
Create Accounting button.

• You submit the Payables Accounting process to
create accounting entries in Payables. Submit this
batch process from the Submit Request window.

• You can also create accounting entries for an
invoice from the related Actions window.
– Select the invoice.
– Click the Actions button.
– Select the Create Accounting check box, and

click OK.
• To account for an invoice batch, query the batch in

the Invoice Batches window, and then click the
Create Accounting button.
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Accounting for Invoices
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Accounting for InvoicesAccounting for Invoices

• For a single invoice, you complete the accounting
process online. For batches, you submit the
accounting process as a request.

• The invoices must be approved before the
accounting entries can be generated.

• For a single invoice, you complete the accounting
process online. For batches, you submit the
accounting process as a request.

• The invoices must be approved before the
accounting entries can be generated.
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Applying Holds

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Applying HoldsApplying Holds

• You can prevent payment and, optionally, prevent
accounting for an invoice by manually applying
one or more holds to it.

• Oracle Payables provides some generic invoice
holds for you, and you can define your own holds
based on your invoice approval needs.

• You can also prevent payment of supplier invoices
by placing a hold on the supplier or the supplier
site instead of on each individual invoice.

• You can prevent payment and, optionally, prevent
accounting for an invoice by manually applying
one or more holds to it.

• Oracle Payables provides some generic invoice
holds for you, and you can define your own holds
based on your invoice approval needs.

• You can also prevent payment of supplier invoices
by placing a hold on the supplier or the supplier
site instead of on each individual invoice.

(Help) Oracle Financial Applications > Oracle Payables > Appendix
> Summary of Approval Hold Codes
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Applying Holds
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Applying HoldsApplying Holds

• There are three types of holds that you can use to
prevent payment of an invoice:
– Invoice hold
– Scheduled payment hold
– Supplier hold

• If an invoice fails Approval, Payables will apply the
appropriate system holds on the invoice.

• There are three types of holds that you can use to
prevent payment of an invoice:
– Invoice hold
– Scheduled payment hold
– Supplier hold

• If an invoice fails Approval, Payables will apply the
appropriate system holds on the invoice.
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Releasing Invoice Holds
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Releasing Invoice HoldsReleasing Invoice Holds

• Release holds from invoices to pay and account
for invoices. You can view the holds on an invoice
in either the Invoice Overview or the Holds window
of the Invoice Workbench. You can see the
number of holds on an invoice in the Invoices
window.

• Identify invoices on hold with the Invoice on Hold
Report and the Matching Hold Detail Report.

• Release holds from invoices to pay and account
for invoices. You can view the holds on an invoice
in either the Invoice Overview or the Holds window
of the Invoice Workbench. You can see the
number of holds on an invoice in the Invoices
window.

• Identify invoices on hold with the Invoice on Hold
Report and the Matching Hold Detail Report.
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Manually Releasing Invoice Holds
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Manually Releasing Invoice HoldsManually Releasing Invoice Holds

• Oracle Payables applies some holds that you
cannot release.

• You can use the Invoice Holds window to view
invoices with these holds, but you cannot
manually release these holds.

• You must correct the exception that caused
Approval to place the hold on the invoice and then
resubmit Approval to release these holds.

• You can correct exceptions by updating the
invoice or the purchase order or by changing your
invoice tolerances.

• Oracle Payables applies some holds that you
cannot release.

• You can use the Invoice Holds window to view
invoices with these holds, but you cannot
manually release these holds.

• You must correct the exception that caused
Approval to place the hold on the invoice and then
resubmit Approval to release these holds.

• You can correct exceptions by updating the
invoice or the purchase order or by changing your
invoice tolerances.
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Review Question
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Review QuestionReview Question

If you have an invoice that the system put on hold
because of an account hold reason, you need to
correct the problem and then resubmit Approval.
A. True
B. False

If you have an invoice that the system put on hold
because of an account hold reason, you need to
correct the problem and then resubmit Approval.
A. True
B. False
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Answer to Review Question
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If you have an invoice that the system put on hold
because of an account hold reason, you need to
correct the problem and then resubmit Approval.

B. False

If you have an invoice that the system put on hold
because of an account hold reason, you need to
correct the problem and then resubmit Approval.

B. False
A. TrueA. True

Answer to Review QuestionAnswer to Review Question
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Adjusting Invoices
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Adjusting InvoicesAdjusting Invoices

You can adjust invoices that meet certain criteria.You can adjust invoices that meet certain criteria.

(Help) Oracle Financial Applications > Oracle Payables > Invoices >
Finding and Reviewing Invoices > Reviewing and Adjusting Invoices
(Help) Oracle Financial Applications > Oracle Payables > Invoices >
Adjustment Charts
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Canceling Invoices
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Canceling InvoicesCanceling Invoices

• You can cancel only unpaid invoices.
• You can cancel any unapproved invoice or an

approved invoice that does not have any effective
payments or accounting holds.

• You can cancel only unpaid invoices.
• You can cancel any unapproved invoice or an

approved invoice that does not have any effective
payments or accounting holds.
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Summary
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SummarySummary

In this module, you should have learned:
• The supplier invoicing process
• The key concepts of invoice processing

In this module, you should have learned:
• The supplier invoicing process
• The key concepts of invoice processing
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Processing Supplier Invoices
Chapter 3
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Processing Supplier Invoices   Oracle Payables
Release 11i
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Processing Supplier Invoices

 Oracle Payables Release 11i

Processing Supplier Invoices

 Oracle Payables Release 11i
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Objectives
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ObjectivesObjectives

After completing this module, you should be able to:
• Enter Standard invoices in the Invoice Workbench
• Enter invoice batches in the Invoice Workbench
• Enter invoice distributions in the Invoice

Workbench
• Enter invoice information in the Invoice Gateway
• Describe the process of importing invoices from

the interface tables

After completing this module, you should be able to:
• Enter Standard invoices in the Invoice Workbench
• Enter invoice batches in the Invoice Workbench
• Enter invoice distributions in the Invoice

Workbench
• Enter invoice information in the Invoice Gateway
• Describe the process of importing invoices from

the interface tables
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Agenda
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AgendaAgenda

• Entering Standard invoices in the Invoice
Workbench

• Entering invoice batches in the the Invoice
Workbench

• Entering invoice distributions in the Invoice
Workbench

• Entering invoice information in the Invoice
Gateway

• Importing invoices from the interface tables

• Entering Standard invoices in the Invoice
Workbench

• Entering invoice batches in the the Invoice
Workbench

• Entering invoice distributions in the Invoice
Workbench

• Entering invoice information in the Invoice
Gateway

• Importing invoices from the interface tables
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Entering Invoices: Overview
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Entering Invoices: OverviewEntering Invoices: Overview

Receive invoicesReceive invoices Enter invoice

Approve invoiceApprove invoice

(Optional)(Optional)
Match to POMatch to PO

or receiptor receipt

File invoiceFile invoice

View invoiceView invoice

Pay invoicePay invoice

100,000100,000

A/PA/P

60,00060,000
10,00010,000
30,00030,000

CreateCreate
accountingaccounting
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Agenda
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AgendaAgenda

• Entering Standard invoices in the Invoice
Workbench

• Entering invoice batches in the Invoice Workbench
• Entering invoice distributions in the Invoice

Workbench
• Entering invoice information in the Invoice

Gateway
• Importing invoices from the interface tables

• Entering Standard invoices in the Invoice
Workbench

• Entering Standard invoices in the Invoice
Workbench
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Invoice Information
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Invoice InformationInvoice Information

DETAIL

Default information

HEADER

Invoices contain the following information:Invoices contain the following information:

Supplier information

Invoice distribution information

Scheduled payment information
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Invoice Information
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Invoice InformationInvoice Information

At a very basic level, invoices are entered, approved,
accounted, and paid. Therefore, basic invoice
processing requires the following actions:
• Entry of header information including invoice type,

supplier name, supplier site, invoice number,
invoice date, and invoice amount

• Entry of invoice payment details such as payment
terms and currency

• Entry of invoice accounting details, including the
GL date of the invoice and the GL accounts to
which the invoice is charged

At a very basic level, invoices are entered, approved,
accounted, and paid. Therefore, basic invoice
processing requires the following actions:
• Entry of header information including invoice type,

supplier name, supplier site, invoice number,
invoice date, and invoice amount

• Entry of invoice payment details such as payment
terms and currency

• Entry of invoice accounting details, including the
GL date of the invoice and the GL accounts to
which the invoice is charged
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Entering Standard Invoice Header Information
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Entering Standard Invoice Header
Information

Entering Standard Invoice Header
Information

How to enter Standard invoice header information:
1. In the Invoices window, select Standard as the
    invoice type.
2. Enter the supplier or supplier number.
3. Select the supplier site to which you will send
    payment of the invoice.
4. Enter the invoice date.
5. Enter the invoice number.

How to enter Standard invoice header information:
1. In the Invoices window, select Standard as the
    invoice type.
2. Enter the supplier or supplier number.
3. Select the supplier site to which you will send
    payment of the invoice.
4. Enter the invoice date.
5. Enter the invoice number.

(Help) Oracle Financial Applications—>Oracle Payables—>Invoices—
>Invoice Workbench—>Entering Basic Invoices in the Invoice Workbench
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Demonstration
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DemonstrationDemonstration

This demonstration covers how to enter Standard
invoice information in the Invoice Workbench.

(N) Invoices—>Entry—>Invoices

This demonstration covers how to enter Standard
invoice information in the Invoice Workbench.

(N) Invoices—>Entry—>Invoices
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Agenda
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AgendaAgenda

• Entering Standard invoices in the Invoice
Workbench

• Entering invoice batches in the Invoice Workbench
• Entering invoice distributions in the Invoice

Workbench
• Entering invoice information in the Invoice

Gateway
• Importing invoices from the interface tables

• Entering Standard invoices in the Invoice
Workbench

• Entering invoice batches in the Invoice Workbench
• Entering invoice distributions in the Invoice

Workbench
• Entering invoice information in the Invoice

Gateway
• Importing invoices from the interface tables

• Entering invoice batches in the Invoice Workbench• Entering invoice batches in the Invoice Workbench
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Overview of Entering BatchesOverview of Entering Batches
  Batch invoices  Batch invoices Enter a batchEnter a batch

of  invoicesof  invoices

Receive invoicesReceive invoices
in the mailin the mail

Prepare a batchPrepare a batch
control formcontrol form

Review batchReview batch
control reportscontrol reports

Update the batchUpdate the batch
control formcontrol form

File invoiceFile invoice
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Entering Invoice BatchesEntering Invoice Batches

Use invoice batches to proactively manage invoice
entry. You can use batches to do the following:
• Enter invoice defaults at the batch level that

override system or supplier site defaults for all
invoices in the batch.

• Maximize accuracy by tracking variances between
the control invoice count and total, and the actual
invoice count and total resulting from your invoice
entry.

• Easily locate a batch online and review the name
of the person who created the batch and the date it
was created.

Use invoice batches to proactively manage invoice
entry. You can use batches to do the following:
• Enter invoice defaults at the batch level that

override system or supplier site defaults for all
invoices in the batch.

• Maximize accuracy by tracking variances between
the control invoice count and total, and the actual
invoice count and total resulting from your invoice
entry.

• Easily locate a batch online and review the name
of the person who created the batch and the date it
was created.



Copyright © Oracle Corporation, 2000. All rights reserved.

Processing Supplier Invoices
Chapter 3 - Page 14

Creating Batch Control Forms

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Creating Batch Control FormsCreating Batch Control Forms

Before entering a batch of invoices, prepare a batch
control form.
• Enter the number of invoices that are expected to

be entered in the control invoice count line of the
batch control form.

• Enter the total sum of the above invoices in the
control invoice total line of the batch control form.

Note: Preparing the Batch Control form is optional
and is not an Oracle Payables function.

Before entering a batch of invoices, prepare a batch
control form.
• Enter the number of invoices that are expected to

be entered in the control invoice count line of the
batch control form.

• Enter the total sum of the above invoices in the
control invoice total line of the batch control form.

Note: Preparing the Batch Control form is optional
and is not an Oracle Payables function.
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Creating Batch Control Forms
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Creating Batch Control FormsCreating Batch Control Forms

After entering a batch of invoices in Oracle Payables,
complete the Batch Control form.
• Enter the actual number of invoices
• Enter the actual invoice total
• Explain the reason for any difference in the control

and actual totals

After entering a batch of invoices in Oracle Payables,
complete the Batch Control form.
• Enter the actual number of invoices
• Enter the actual invoice total
• Explain the reason for any difference in the control

and actual totals
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Sample Batch Control FormSample Batch Control Form

Batch Control Form
Batch Name : JS03041998 Date: 03/04/98

Control Invoice Count: 20 Control Invoice Total: $2,600.78

Actual Invoice Count:   19 Actual Invoice Total:   $2,200.78
Count Difference:            1 Total Difference :         $   400.00

Entered by: John Smith Entry Time (elapsed): 15 minutes

Notes: Invoice #300941 for supplier ABC Corporation was a
duplicate.
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Entering Invoices in BatchesEntering Invoices in Batches

Use the Invoice Batches window to start entering an
invoice batch.
To enter an invoice batch:
1.  Enter a unique value in the Batch Name field.
2.  Enter the number of invoices that are in the batch

in the Control Count field.
3.  Enter the sum of the invoice amounts that are in

the batch in the Control Amount field.
4.  Enter any invoice defaults you want to use for the

invoices.
5.  Click the Invoices button and enter the invoices.

Use the Invoice Batches window to start entering an
invoice batch.
To enter an invoice batch:
1.  Enter a unique value in the Batch Name field.
2.  Enter the number of invoices that are in the batch

in the Control Count field.
3.  Enter the sum of the invoice amounts that are in

the batch in the Control Amount field.
4.  Enter any invoice defaults you want to use for the

invoices.
5.  Click the Invoices button and enter the invoices.

(Help) Oracle Financial Applications—>Oracle Payables—>Invoices—
>Invoice Batches—>Entering Invoice Batches in the Invoice Workbench
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Approving Invoices in BatchesApproving Invoices in Batches

You can submit online approval for invoice batches:
1.  In the Invoice Batches window, find the invoice

batch or batches that contain the invoices for
which you want to submit the Approval process.

2.  Select Approve, and Payables submits the
Approval process to review each invoice that is
included in each batch you select.

You can submit online approval for invoice batches:
1.  In the Invoice Batches window, find the invoice

batch or batches that contain the invoices for
which you want to submit the Approval process.

2.  Select Approve, and Payables submits the
Approval process to review each invoice that is
included in each batch you select.
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DemonstrationDemonstration

This demonstration covers how to enter invoice
batches in the Invoice Workbench.

(N) Invoices—>Entry—>Invoice Batches

This demonstration covers how to enter invoice
batches in the Invoice Workbench.

(N) Invoices—>Entry—>Invoice Batches
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AgendaAgenda

• Entering Standard invoices in the Invoice
Workbench

• Entering invoice batches in the Invoice Workbench
• Entering invoice distributions in the Invoice

Workbench
• Entering invoice information in the Invoice

Gateway
• Importing invoices from the interface tables

• Entering Standard invoices in the Invoice
Workbench

• Entering invoice batches in the Invoice Workbench
• Entering invoice distributions in the Invoice

Workbench
• Entering invoice information in the Invoice

Gateway
• Importing invoices from the interface tables

• Entering invoice distributions in the Invoice
Workbench

• Entering invoice distributions in the Invoice
Workbench
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Entering DistributionsEntering Distributions

• Enter distributions for an invoice to associate the
total invoice amount with various expense or asset
accounts.

• During approval, Oracle Payables places a hold on
an invoice if the distribution total does not equal
the invoice total. The distribution variance hold is
placed on the invoice and prevents payment and
accounting for the invoice.

• Enter distributions for an invoice to associate the
total invoice amount with various expense or asset
accounts.

• During approval, Oracle Payables places a hold on
an invoice if the distribution total does not equal
the invoice total. The distribution variance hold is
placed on the invoice and prevents payment and
accounting for the invoice.
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Type Description

Item Records the amount a supplier charges for
goods or services purchased

Tax Records the sales or other tax amount due
on goods or services purchased

Freight Records the amount a supplier charges for
shipping and handling

Miscellaneous Records the amount for miscellaneous 
expenses on an invoice

Invoice Distribution TypesInvoice Distribution Types
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Invoice Distribution Types
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Type Description

Withholding Records the amount of taxes withheld from
an invoice

Prepayment Records the amount of a prepayment
applied to an invoice

Invoice Distribution TypesInvoice Distribution Types
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Review QuestionReview Question

Which of the following is an invoice distribution
type?
1. Manual
2. Matching
3. Allocation
4. Withholding
5. Distribution set

Which of the following is an invoice distribution
type?
1. Manual
2. Matching
3. Allocation
4. Withholding
5. Distribution set
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Answer to Review QuestionAnswer to Review Question

Which of the following is an invoice distribution
type?
1. Manual
2. Matching
3. Allocation
4. Withholding
5. Distribution set

Which of the following is an invoice distribution
type?
1. Manual
2. Matching
3. Allocation
4. Withholding
5. Distribution set
4. Withholding4. Withholding
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Entering DistributionsEntering Distributions

You can enter distributions in any of five ways:
• Entering lines manually
• Automatically creating a freight or tax line
• Using allocation
• Using a distribution set
• Matching to a purchase order or receipt

You can enter distributions in any of five ways:
• Entering lines manually
• Automatically creating a freight or tax line
• Using allocation
• Using a distribution set
• Matching to a purchase order or receipt

(Help) Oracle Financial Applications—>Oracle Payables—>Invoices—
>Invoice Workbench—>Entering Distributions in the Invoice Workbench
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Manually Entering DistributionsManually Entering Distributions

1.  Select a distribution type.
2.  Enter the distribution amount.
3.  Enter the GL account to determine where the

invoice gets charged; for example, the company,
cost center, and GL account.

4.  Enter the GL date. The distribution GL date
determines the accounting period to which the
distribution will post in the general ledger.

1.  Select a distribution type.
2.  Enter the distribution amount.
3.  Enter the GL account to determine where the

invoice gets charged; for example, the company,
cost center, and GL account.

4.  Enter the GL date. The distribution GL date
determines the accounting period to which the
distribution will post in the general ledger.

(Help) Oracle Financial Applications—>Oracle Payables—>Invoices—
>Invoice Workbench—>Entering Distributions in the Invoice Workbench
(scroll down to Entering Distributions Manually in the Distributions
window)
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DemonstrationDemonstration

This demonstration covers how to manually enter
distributions in the Invoice Workbench.

(N) Invoices—>Entry—>Invoices (B) Distributions

This demonstration covers how to manually enter
distributions in the Invoice Workbench.

(N) Invoices—>Entry—>Invoices (B) Distributions
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Entering Freight Distributions
for an Invoice

Entering Freight Distributions
for an Invoice

You can record freight charges by:
• Manually entering freight distributions
• Allocating freight to invoice distributions
• Having Payables automatically create a freight

distribution based on a freight amount you enter

You can record freight charges by:
• Manually entering freight distributions
• Allocating freight to invoice distributions
• Having Payables automatically create a freight

distribution based on a freight amount you enter

(Help) Oracle Financial Applications—>Oracle Payables—>Invoices —
>Freight on Invoices
(Help) Oracle Financial Applications—>Oracle Payables—>Invoices —
>Invoice Workbench—>Allocating Freight and Miscellaneous
Distributions by Allocation
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Enabling Automatically Create Freight
Distribution

Enabling Automatically Create Freight
Distribution

To set up Payables to default a freight account and
automatically enable the Create Freight Distribution
check box in the Invoices window during invoice
entry, set the following Payables options:
• Enable the Automatically Create Freight

Distribution option
• Enter a default freight account. Payables uses this

account as the default freight account for an
invoice. You can override this account during
invoice entry.

To set up Payables to default a freight account and
automatically enable the Create Freight Distribution
check box in the Invoices window during invoice
entry, set the following Payables options:
• Enable the Automatically Create Freight

Distribution option
• Enter a default freight account. Payables uses this

account as the default freight account for an
invoice. You can override this account during
invoice entry.
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Enabling Automatically Create Freight Distribution
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Enabling Automatically Create Freight
Distribution

Enabling Automatically Create Freight
Distribution

• If you select the Create Freight Distribution check
box in the Invoices window, Payables
automatically creates a single freight distribution
using the freight amount and freight account that
you enter for an invoice.

• If you usually allocate freight to invoice
distributions or enter freight distributions
manually, do not enable this option.

• If you select the Create Freight Distribution check
box in the Invoices window, Payables
automatically creates a single freight distribution
using the freight amount and freight account that
you enter for an invoice.

• If you usually allocate freight to invoice
distributions or enter freight distributions
manually, do not enable this option.
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Creating Distributions by AllocationCreating Distributions by Allocation

You can use the Charge Allocations window to
automatically create tax, freight, or miscellaneous
distributions.
In the Charge Allocations window, you specify the
following:
• The charge amount and type (freight, tax, or

miscellaneous)
• The distributions to which the charge will be

allocated

You can use the Charge Allocations window to
automatically create tax, freight, or miscellaneous
distributions.
In the Charge Allocations window, you specify the
following:
• The charge amount and type (freight, tax, or

miscellaneous)
• The distributions to which the charge will be

allocated

(Help) Oracle Financial Applications—>Oracle Payables—>Invoices —
>Invoice Workbench—>Creating Distributions by Allocation
(Help) Oracle Financial Applications—>Oracle Payables—>Invoices—
>Allocation
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Creating Distributions by Allocation
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Creating Distributions by AllocationCreating Distributions by Allocation

• The charge amount associated with each
distribution. Either you can specify an exact
amount to allocate to each distribution, or you can
prorate the charge amount across all selected
distributions by selecting the Prorate check box.

For each selected distribution, Payables creates a
charge distribution and records the allocation. The
new distribution has the same GL account as the
distribution to which you allocate it. After Payables
creates the distribution, you can update the account
any time before the invoice is accounted.

• The charge amount associated with each
distribution. Either you can specify an exact
amount to allocate to each distribution, or you can
prorate the charge amount across all selected
distributions by selecting the Prorate check box.

For each selected distribution, Payables creates a
charge distribution and records the allocation. The
new distribution has the same GL account as the
distribution to which you allocate it. After Payables
creates the distribution, you can update the account
any time before the invoice is accounted.
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Allocating Freight, Tax,
and Miscellaneous Lines
Allocating Freight, Tax,

and Miscellaneous Lines

TaxTax

FreightFreight MiscellaneousMiscellaneous

ItemItem

Prepayment LinePrepayment Line
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Allocating Other Charges within the Same
Invoice

Allocating Other Charges within the Same
Invoice

The main rules of the Allocation window are the
following:
1.  You can allocate Tax to Freight, Miscellaneous,

Item, and Prepayment lines.
2.  You can allocate Freight and Miscellaneous lines

only to Item lines. You cannot allocate these
charges to Tax lines.

3.  You cannot allocate any line to itself.
4.  You cannot allocate an Item line.
5.  The charge amount must be fully allocated before

you can save the allocation.

The main rules of the Allocation window are the
following:
1.  You can allocate Tax to Freight, Miscellaneous,

Item, and Prepayment lines.
2.  You can allocate Freight and Miscellaneous lines

only to Item lines. You cannot allocate these
charges to Tax lines.

3.  You cannot allocate any line to itself.
4.  You cannot allocate an Item line.
5.  The charge amount must be fully allocated before

you can save the allocation.
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Allocating Other Charges within the Same
Invoice

Allocating Other Charges within the Same
Invoice

6.  During the Approval process, any charge that is
not fully allocated (either not allocated, or a
corresponding distribution was reversed or
deleted) and is not associated with a receipt, will
be prorated to all eligible distributions on the
invoice.

6.  During the Approval process, any charge that is
not fully allocated (either not allocated, or a
corresponding distribution was reversed or
deleted) and is not associated with a receipt, will
be prorated to all eligible distributions on the
invoice.
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Allocation RestrictionsAllocation Restrictions

• Canceled invoices
• Paid invoices (if the invoice is partially or fully

paid and the Allow Adjustments to Paid Invoices
option is not enabled)

• Applied prepayments
• Multiple item distributions, each matched to a

different PO distribution, cannot receive
allocations from a single nonrecoverable tax
distribution.

• Encumbered tax distributions
• Accounted allocations

• Canceled invoices
• Paid invoices (if the invoice is partially or fully

paid and the Allow Adjustments to Paid Invoices
option is not enabled)

• Applied prepayments
• Multiple item distributions, each matched to a

different PO distribution, cannot receive
allocations from a single nonrecoverable tax
distribution.

• Encumbered tax distributions
• Accounted allocations
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Review QuestionReview Question

You can allocate a Miscellaneous line to which of the
following lines?
1. Tax
2. Item
3. Freight
4. Prepayment
5. Miscellaneous

You can allocate a Miscellaneous line to which of the
following lines?
1. Tax
2. Item
3. Freight
4. Prepayment
5. Miscellaneous
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Answer to Review QuestionAnswer to Review Question

You can allocate a Miscellaneous line to which of the
following lines?
1. Tax
2. Item
3. Freight
4. Prepayment
5. Miscellaneous

You can allocate a Miscellaneous line to which of the
following lines?
1. Tax
2. Item
3. Freight
4. Prepayment
5. Miscellaneous

2. Item2. Item
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DemonstrationDemonstration

This demonstration covers how to create
distributions by allocation in the Invoice Workbench.

(N) Invoices—>Entry—>Invoices (B) Distributions (B)
Allocate

This demonstration covers how to create
distributions by allocation in the Invoice Workbench.

(N) Invoices—>Entry—>Invoices (B) Distributions (B)
Allocate
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Distribution SetsDistribution Sets

• Use a distribution set to automatically enter
distributions for an invoice when you are not
matching to a purchase order.

• Enter a default distribution set to a supplier site so
that Oracle Payables will use it for every invoice
you enter for that supplier site, or assign a
distribution set to an invoice when you enter it.

• Use a distribution set to automatically enter
distributions for an invoice when you are not
matching to a purchase order.

• Enter a default distribution set to a supplier site so
that Oracle Payables will use it for every invoice
you enter for that supplier site, or assign a
distribution set to an invoice when you enter it.

(Help) Oracle Financial Applications—>Oracle Payables—> Setup—
>Distribution Sets
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Defining a Distribution SetDefining a Distribution Set

• Enter a name that describes the use of the
distribution set, and identify the distribution set as
either full (with all percent amounts totaling 100%)
or skeleton (with all percent amounts totaling 0%).

• If you create a skeleton distribution set, include
“skeleton” in the name to remind you during
invoice entry to enter the amounts on the invoice
distributions.

• Define an unlimited number of distribution lines
for a distribution set.

• Optionally, assign an income tax type or an
invoice tax name to a distribution set.

• Enter a name that describes the use of the
distribution set, and identify the distribution set as
either full (with all percent amounts totaling 100%)
or skeleton (with all percent amounts totaling 0%).

• If you create a skeleton distribution set, include
“skeleton” in the name to remind you during
invoice entry to enter the amounts on the invoice
distributions.

• Define an unlimited number of distribution lines
for a distribution set.

• Optionally, assign an income tax type or an
invoice tax name to a distribution set.
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DemonstrationDemonstration

This demonstration covers how to define and use a
distribution set.

(N) Setup—>Invoice—>Distribution Sets
(N) Invoices—>Entry—>Invoices

This demonstration covers how to define and use a
distribution set.

(N) Setup—>Invoice—>Distribution Sets
(N) Invoices—>Entry—>Invoices
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Practice 1 OverviewPractice 1 Overview

This practice covers entering an invoice with a
distribution set.
This practice covers entering an invoice with a
distribution set.
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Practice 1 InstructionsPractice 1 Instructions

You have received the following invoice. Enter the
invoice into the system and assign the Rent Expense
distribution set.
• Invoice #: Assigned by the instructor
• Date: Today
• Terms: Immediate
• Supplier: Star Gate Ltd
• Description: Monthly Rent Charges
• Total: $2567.89

You have received the following invoice. Enter the
invoice into the system and assign the Rent Expense
distribution set.
• Invoice #: Assigned by the instructor
• Date: Today
• Terms: Immediate
• Supplier: Star Gate Ltd
• Description: Monthly Rent Charges
• Total: $2567.89

Practice 1 Solutions
1. Navigate to the Invoices window.
(N) Invoices—>Entry—>Invoices
2. Accept the Standard as the default for invoice type.
3. Enter Star Gate Ltd in the Supplier field.
4. Select Star Gate - Pay as the site.
5. Because the invoice is dated today, press the [Tab] key to accept the default
date.
6. Enter the invoice number assigned by the instructor.
7. Enter 2,567.89 in the Invoice Amount field.
8. In the Distribution Set field, enter the Rent Expense distribution set.
9. In the Description field, enter the description for this invoice.
10. In the Terms field, select Immediate.
11. Save your work.
12. Click Distributions.
13. In the Distributions window, verify that the distribution amount is equal to
the invoice amount.
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AgendaAgenda

• Entering Standard invoices in the Invoice
Workbench

• Entering invoice batches in the Invoice Workbench
• Entering invoice distributions in the Invoice

Workbench
• Entering invoice information in the Invoice

Gateway
• Importing invoices from the interface tables

• Entering Standard invoices in the Invoice
Workbench

• Entering invoice batches in the Invoice Workbench
• Entering invoice distributions in the Invoice

Workbench
• Entering invoice information in the Invoice

Gateway
• Importing invoices from the interface tables

• Entering invoice information in the Invoice
Gateway

• Entering invoice information in the Invoice
Gateway
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Invoice GatewayInvoice Gateway

• The Invoice Gateway is designed for rapid, high-
volume entry of standard and credit memo
invoices that do not require extensive online
validation and defaulting of values during entry.

• After entering the invoice records, you import
them. During Payables Open Interface Import,
Payables validates the invoice information and
creates regular invoices in Payables that you can
then approve, account for, and pay.

• The Invoice Gateway is designed for rapid, high-
volume entry of standard and credit memo
invoices that do not require extensive online
validation and defaulting of values during entry.

• After entering the invoice records, you import
them. During Payables Open Interface Import,
Payables validates the invoice information and
creates regular invoices in Payables that you can
then approve, account for, and pay.
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Entering Invoice Gateway Identification
Information

Entering Invoice Gateway Identification
Information

• When you enter invoice records in the Invoice
Gateway window, you group the invoice records
by assigning the same Gateway Batch name to
each invoice.

• When you enter a value for Gateway Batch in the
Invoice Gateway Identification window, the system
assigns that Gateway Batch name to each invoice
record you enter.

• When you enter invoice records in the Invoice
Gateway window, you group the invoice records
by assigning the same Gateway Batch name to
each invoice.

• When you enter a value for Gateway Batch in the
Invoice Gateway Identification window, the system
assigns that Gateway Batch name to each invoice
record you enter.

(Help) Oracle Financial Applications—>Oracle Payables—>Invoices—
>Invoice Gateway
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How to Enter Invoice Gateway
Identification Information

How to Enter Invoice Gateway
Identification Information

1.  The Source field identifies where the invoices
originated. Enter either Invoice Gateway or a value
that you defined in the Oracle Payables Lookups
window.
Note: If you define a source name that you use for
Invoice Gateway invoice records, do not use the
value for any other method of entering data in the
Open Interface tables.

1.  The Source field identifies where the invoices
originated. Enter either Invoice Gateway or a value
that you defined in the Oracle Payables Lookups
window.
Note: If you define a source name that you use for
Invoice Gateway invoice records, do not use the
value for any other method of entering data in the
Open Interface tables.
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How to Enter Invoice Gateway Identification Information
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How to Enter Invoice Gateway
Identification Information

How to Enter Invoice Gateway
Identification Information

2.  Enter a unique value in the Gateway Batch field.
When you enter invoice records in the Invoice
Gateway window, you group the invoice records in
a Gateway Batch by assigning the same Gateway
Batch name to each invoice.

3.  You can use the Gateway Batch name to query the
group of invoice records in the Invoice Gateway
window, and to identify a group of invoice records
that you want to import together.

2.  Enter a unique value in the Gateway Batch field.
When you enter invoice records in the Invoice
Gateway window, you group the invoice records in
a Gateway Batch by assigning the same Gateway
Batch name to each invoice.

3.  You can use the Gateway Batch name to query the
group of invoice records in the Invoice Gateway
window, and to identify a group of invoice records
that you want to import together.
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How to Enter Invoice Header InformationHow to Enter Invoice Header Information

Enter the invoice header information in this region.
The following fields are required:
• Supplier or Supplier Num
• Site
• Invoice Amount

Enter the invoice header information in this region.
The following fields are required:
• Supplier or Supplier Num
• Site
• Invoice Amount

(Help) Oracle Financial Applications—>Oracle Payables—>Invoices—
>Invoice Gateway—>Entering Invoice Records in the Invoice Gateway
Window
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How to Enter Invoice Line InformationHow to Enter Invoice Line Information

Use this region to enter line information for an
invoice. Enter at least one invoice line per invoice.
The following fields are required in this region:
• Type
• Amount
You can create distributions by manually entering a
value for the account, or you can create them
automatically by using distribution sets, proration of
charges, purchase order matching, or receipt
matching.

Use this region to enter line information for an
invoice. Enter at least one invoice line per invoice.
The following fields are required in this region:
• Type
• Amount
You can create distributions by manually entering a
value for the account, or you can create them
automatically by using distribution sets, proration of
charges, purchase order matching, or receipt
matching.

(Help) Oracle Financial Applications—>Oracle Payables—>Invoices—
>Invoice Gateway—>Entering Invoice Records in the Invoice Gateway
Window
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Invoice Line InformationInvoice Line Information

• When Oracle Payables imports the invoice record,
it creates one or more distributions for the invoice
based on the information you enter in the invoice
lines region.

• Payables uses distributions to create general
ledger journal entries for invoices. An invoice can
have an unlimited number of distributions.

• When Oracle Payables imports the invoice record,
it creates one or more distributions for the invoice
based on the information you enter in the invoice
lines region.

• Payables uses distributions to create general
ledger journal entries for invoices. An invoice can
have an unlimited number of distributions.
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Invoice GatewayInvoice Gateway

Invoice GatewayInvoice Gateway
windowwindow

Payables OpenPayables Open
Interface ImportInterface Import

Invoices areInvoices are
created in Payables.created in Payables.

Invoice
header and 

line
information
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Creating InvoicesCreating Invoices

• When entering invoice data in the Invoice
Gateway, you are populating the Payables Open
Interface table with that invoice data. You can use
the Payables Open Interface Import program to
create Payables invoices from invoice data in the
Payables Open Interface tables.

• During the Import process, Payables validates
invoice records and rejects invoice records that
have insufficient or invalid data. Successfully
imported invoices have distributions and
scheduled payments, and can be queried,
modified, and approved in the Invoice Workbench.

• When entering invoice data in the Invoice
Gateway, you are populating the Payables Open
Interface table with that invoice data. You can use
the Payables Open Interface Import program to
create Payables invoices from invoice data in the
Payables Open Interface tables.

• During the Import process, Payables validates
invoice records and rejects invoice records that
have insufficient or invalid data. Successfully
imported invoices have distributions and
scheduled payments, and can be queried,
modified, and approved in the Invoice Workbench.
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Review QuestionReview Question

The Invoice Gateway can be used to enter which of
the following invoices?
1. PO default
2. Prepayment
3. Debit memo
4. Credit memo
5. Expense report

The Invoice Gateway can be used to enter which of
the following invoices?
1. PO default
2. Prepayment
3. Debit memo
4. Credit memo
5. Expense report
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Answer to Review QuestionAnswer to Review Question

The Invoice Gateway can be used to enter which of
the following invoices?
1. PO default
2. Prepayment
3. Debit memo
4. Credit memo
5. Expense report

The Invoice Gateway can be used to enter which of
the following invoices?
1. PO default
2. Prepayment
3. Debit memo
4. Credit memo
5. Expense report
4. Credit memo4. Credit memo
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DemonstrationDemonstration

This demonstration covers how to enter invoice
information and create invoices in the Invoice
Gateway.

(N) Invoices—>Entry—>Invoice Gateway

This demonstration covers how to enter invoice
information and create invoices in the Invoice
Gateway.

(N) Invoices—>Entry—>Invoice Gateway
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Practice 2 OverviewPractice 2 Overview

This practice covers entering an invoice in the
Invoice Gateway.
This practice covers entering an invoice in the
Invoice Gateway.



Copyright © Oracle Corporation, 2000. All rights reserved.

Processing Supplier Invoices
Chapter 3 - Page 60

Practice 2 Instructions

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Practice 2 InstructionsPractice 2 Instructions

You have received an invoice from the Advanced
Network Devices that you will enter in the Invoice
Gateway.
• Invoice #: Assigned by the instructor
• Date: Today
• Supplier: Advanced Network Devices
• Description: Five Dell Laptops
• Total: $15,500.00

You have received an invoice from the Advanced
Network Devices that you will enter in the Invoice
Gateway.
• Invoice #: Assigned by the instructor
• Date: Today
• Supplier: Advanced Network Devices
• Description: Five Dell Laptops
• Total: $15,500.00

Practice 2 Solutions
1. Navigate to the Invoice Gateway Identification window.
(N) Invoices—>Entry—>Invoice Gateway
2. Accept Invoice Gateway as the default value in the Source field.
3. Enter XX Batch (XX is your unique identifier) in the Gateway Batch field.
4. Select Enter.
5. Enter the invoice number assigned by the instructor.
6. Enter Advanced Network Devices as the supplier and enter Santa
Clara as the supplier site.
7. Enter the dollar amount of the invoice in the Invoice Amount field.
8. Enter Item in the Type field.
9. Enter the invoice line amount.
10. Enter 01.130.1560.0000.000 in the Account field.
11. Enter the line description in the Description field.
12. Save your work.
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AgendaAgenda

• Entering Standard invoices in the Invoice
Workbench

• Entering invoice batches in the Invoice Workbench
• Entering invoice distributions in the Invoice

Workbench
• Entering invoice information in the Invoice

Gateway
• Importing invoices from the interface tables

• Entering Standard invoices in the Invoice
Workbench

• Entering invoice batches in the Invoice Workbench
• Entering invoice distributions in the Invoice

Workbench
• Entering invoice information in the Invoice

Gateway
• Importing invoices from the interface tables• Importing invoices from the interface tables• Importing invoices from the interface tables
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Payables Open Interface TablesPayables Open Interface Tables

The Payables Open Interface tables store invoice data
from the following sources:
• Invoice records that you enter in the Invoice

Gateway window
• Electronic invoices from Oracle e-Commerce

Gateway
• Invoices that you load with SQL*Loader
• Rent invoices from Oracle Property Manager
• Credit card transaction data

The Payables Open Interface tables store invoice data
from the following sources:
• Invoice records that you enter in the Invoice

Gateway window
• Electronic invoices from Oracle e-Commerce

Gateway
• Invoices that you load with SQL*Loader
• Rent invoices from Oracle Property Manager
• Credit card transaction data
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Payables Open Interface Import ProgramPayables Open Interface Import Program

Submit the Payables Open Interface Import program
to create invoices from invoice data in the Payables
Open Interface tables. This program:
• Validates the invoice data
• Provides some defaults during import (for

example, supplier site payment terms)
• Rejects invoices that have insufficient or invalid

data
• Creates invoices in the Payables system that can

then be queried, approved, accounted, and
modified in the Invoice Workbench

Submit the Payables Open Interface Import program
to create invoices from invoice data in the Payables
Open Interface tables. This program:
• Validates the invoice data
• Provides some defaults during import (for

example, supplier site payment terms)
• Rejects invoices that have insufficient or invalid

data
• Creates invoices in the Payables system that can

then be queried, approved, accounted, and
modified in the Invoice Workbench
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Integration with Oracle e-Commerce
Gateway

Integration with Oracle e-Commerce
Gateway

You can use Oracle Payables and Oracle e-Commerce
Gateway to import invoice data from your suppliers.
• Oracle e-Commerce Gateway uploads the

supplier’s invoice information into the Payables
Open Interface tables.

• Payables creates a notification for invoices that
were successfully imported and those that failed
import. You can send this notification to your
supplier through the e-Commerce Gateway.

You can use Oracle Payables and Oracle e-Commerce
Gateway to import invoice data from your suppliers.
• Oracle e-Commerce Gateway uploads the

supplier’s invoice information into the Payables
Open Interface tables.

• Payables creates a notification for invoices that
were successfully imported and those that failed
import. You can send this notification to your
supplier through the e-Commerce Gateway.
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Loading Electronic Flat FilesLoading Electronic Flat Files

You can use SQL*Loader to import into the interface
table a flat file that contains invoice information. For
example, you might want to use this to import legacy
invoice data.

You can use SQL*Loader to import into the interface
table a flat file that contains invoice information. For
example, you might want to use this to import legacy
invoice data.

(Help) Oracle Financial Applications—>Oracle Payables—>Appendix—
>Payables Open Interface Tables—>Using SQL*Loader
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Review QuestionReview Question

Which of the following programs is used to import
invoices from the e-Commerce Gateway?
1. EDI Gateway program
2. EDI Invoice Inbound program
3. Application Advice Outbound program
4. Payables Open Interface Import program
5. Payables Open Interface Outbound Advice program

Which of the following programs is used to import
invoices from the e-Commerce Gateway?
1. EDI Gateway program
2. EDI Invoice Inbound program
3. Application Advice Outbound program
4. Payables Open Interface Import program
5. Payables Open Interface Outbound Advice program
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Answer to Review QuestionAnswer to Review Question

Which of the following programs is used to import
invoices from the e-Commerce Gateway?
1. EDI Gateway program
2. EDI Invoice Inbound program
3. Application Advice Outbound program
4. Payables Open Interface Import program
5. Payables Open Interface Outbound Advice program

Which of the following programs is used to import
invoices from the e-Commerce Gateway?
1. EDI Gateway program
2. EDI Invoice Inbound program
3. Application Advice Outbound program
4. Payables Open Interface Import program
5. Payables Open Interface Outbound Advice program
4. Payables Open Interface Import program4. Payables Open Interface Import program
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SummarySummary

In this lesson, you should have learned how to:
• Enter Standard invoices in the Invoice Workbench
• Enter invoice batches in the Invoice Workbench
• Enter invoice distributions in the Invoice

Workbench
• Enter invoice information in the Invoice Gateway
• Describe the process of importing invoices from

the interface tables

In this lesson, you should have learned how to:
• Enter Standard invoices in the Invoice Workbench
• Enter invoice batches in the Invoice Workbench
• Enter invoice distributions in the Invoice

Workbench
• Enter invoice information in the Invoice Gateway
• Describe the process of importing invoices from

the interface tables



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Managing and Approving Invoices
Chapter 4 - Page 1

R11i Managing and
Approving Invoices
Chapter 4



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Managing and Approving Invoices
Chapter 4 - Page 2

Managing and Approving Invoices
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Managing and Approving InvoicesManaging and Approving Invoices

Oracle Payables Release 11iOracle Payables Release 11i

Notations:
(N) = Navigator
(T) = Tab
(I) = Icon
(H) = Hyperlink
(B) = Button
(Help) = Oracle Applications Help System
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ObjectivesObjectives

After completing this lesson, you should be able to:
• Inquire on invoices
• Apply and release holds
• Approve invoices
• Adjust or cancel invoices
• Adjust purchase order matched invoices

After completing this lesson, you should be able to:
• Inquire on invoices
• Apply and release holds
• Approve invoices
• Adjust or cancel invoices
• Adjust purchase order matched invoices
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Agenda
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AgendaAgenda

• Inquiring on invoices
• Applying and releasing holds
• Approving invoices
• Adjusting or canceling invoices
• Adjusting purchase order matched invoices

• Inquiring on invoices
• Applying and releasing holds
• Approving invoices
• Adjusting or canceling invoices
• Adjusting purchase order matched invoices
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Invoice Inquiry: OverviewInvoice Inquiry: Overview

After completing this section, you should be able to:
• Find invoices
• Find invoice distributions
• Calculate supplier balances
• Review high-level invoice information

After completing this section, you should be able to:
• Find invoices
• Find invoice distributions
• Calculate supplier balances
• Review high-level invoice information
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Invoice Inquiry: Overview
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Invoice Inquiry: OverviewInvoice Inquiry: Overview
Enter or importEnter or import
invoicesinvoices

Approve invoice

OptionallyOptionally
match to POmatch to PO

or receiptor receipt

CreateCreate
accountingaccounting

View invoiceView invoice

Pay invoicePay invoice

Receive invoicesReceive invoices
electronically orelectronically or

in the mailin the mail

100,000100,000

APAP

60,00060,000
10,00010,000
30,00030,000

Approve invoiceApprove invoice
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Finding Invoices
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Finding InvoicesFinding Invoices

Enter multiple search criteria in the Find Invoices
window.
OR
Enter a query using your search criteria in the
Invoices window.

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Finding and Reviewing Invoices >
Finding Invoices
(N) Invoices > Inquiry > Invoices
(N) Invoices > Entry > Invoices (M) View > Find
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Finding Invoice DistributionsFinding Invoice Distributions

Query an invoice in the Invoices window and click
Distributions.
OR
Enter a query in the Distributions window to find
specific distribution lines for the invoice.

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Finding and Reviewing Invoices >
Reviewing Invoice Distributions
(N) Invoices > Entry > Invoices (B) Distributions (M) View > Find
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Calculating Supplier BalancesCalculating Supplier Balances

Use the Calculate Balance Owed window to:
• View the balance that you owe to a supplier
• View the number of unpaid invoices and

prepayments for the supplier
• Convert foreign currency invoices into your

functional currency for display purposes

Use the Calculate Balance Owed window to:
• View the balance that you owe to a supplier
• View the number of unpaid invoices and

prepayments for the supplier
• Convert foreign currency invoices into your

functional currency for display purposes

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Finding and Reviewing Invoices >
Calculating a Supplier or Supplier Site Balance
(N) Invoices > Inquiry > Invoices (B) Calculate Balance Owed
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Demonstration
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DemonstrationDemonstration

This demonstration covers how to calculate a
supplier balance.

(N) Invoices > Inquiry > Invoices (B) Calculate
Balance Owed

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Finding and Reviewing Invoices >
Calculating a Supplier or Supplier Site Balance
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Reviewing High-Level Invoice InformationReviewing High-Level Invoice Information

Use the Invoice Overview window to quickly review:
• Supplier information
• Invoice information
• Active holds
• Scheduled payments
• Actual payments
• Purchase order information
Note: The information in this window is display only.

Use the Invoice Overview window to quickly review:
• Supplier information
• Invoice information
• Active holds
• Scheduled payments
• Actual payments
• Purchase order information
Note: The information in this window is display only.

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Finding and Reviewing Invoices >
Invoice Overview
(N) Invoices > Inquiry > Invoice Overview
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Reviewing High-Level Invoice Information

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Reviewing High-Level Invoice InformationReviewing High-Level Invoice Information

In the Invoice Overview window, you can enter a
query or use the Find Invoices window to retrieve an
invoice.
To adjust, approve, or see more information about the
invoice, navigate to the Invoices window.

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Finding and Reviewing Invoices >
Invoice Overview
(N) Invoices > Inquiry > Invoice Overview
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Review QuestionReview Question

The director of corporate purchasing wants to know
how many unpaid invoices are in Oracle Payables for
a certain supplier. You can find this information in the
Invoices window.

True or False?



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Managing and Approving Invoices
Chapter 4 - Page 14

Review Question Solution

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Review Question SolutionReview Question Solution

The director of corporate purchasing wants to know
how many unpaid invoices are in Oracle Payables for
a certain supplier. You can find this information in the
Invoices window.

True or False?
Answer:
False
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AgendaAgenda

• Inquiring on invoices
• Applying and releasing holds
• Approving invoices
• Adjusting or canceling invoices
• Adjusting purchase order matched invoices

• Inquiring on invoices
• Applying and releasing holds
• Approving invoices
• Adjusting or canceling invoices
• Adjusting purchase order matched invoices
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Applying and Releasing Invoice Holds:
Overview

Applying and Releasing Invoice Holds:
Overview

After completing this section, you should be able to:
• Describe the various hold types in Oracle

Payables
• Apply holds to selected invoices
• Apply holds to invoices for a supplier site
• Apply holds to scheduled payments
• Release holds

After completing this section, you should be able to:
• Describe the various hold types in Oracle

Payables
• Apply holds to selected invoices
• Apply holds to invoices for a supplier site
• Apply holds to scheduled payments
• Release holds
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Holds
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HoldsHolds

• Holds prevent payment and, sometimes,
accounting of an invoice

• Oracle Payables applies holds to invoices that fail
Approval

• You can manually apply certain holds

• Holds prevent payment and, sometimes,
accounting of an invoice

• Oracle Payables applies holds to invoices that fail
Approval

• You can manually apply certain holds

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Holds > Applying Holds
(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Setup > Invoice Approvals > Invoice Approvals
(N) Invoices > Entry > Invoices (B) Holds
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Acct Hold Reason                      No

Funds Hold Reason                  Mixed

Insufficient Information          No

Invoice Hold Reason                            Yes

Matching Hold Reason          Mixed

Period Hold Type                             No

PO Req Hold Reason                       No

Variance Hold Reason          Mixed

Hold TypesHold Types

Review the hold types that Oracle Payables automaticallyReview the hold types that Oracle Payables automatically
places during Approval.places during Approval.

   User Manually
 Hold Types        Predefined Definable Releasable

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Appendix > Summary of Approval Hold Codes
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Manually Applying Holds
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Manually Applying HoldsManually Applying Holds

• Invoice hold
• Supplier hold
• Scheduled payment hold

• Invoice hold
• Supplier hold
• Scheduled payment hold

There are three types of holds that you can use to
prevent payment of an invoice:

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Holds > Applying Holds
(N) Invoices > Entry > Invoices (B) Holds
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Manually Applying Invoice Holds
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Manually Applying Invoice HoldsManually Applying Invoice Holds

Oracle Payables provides some generic invoice holds
for you, and you can define your own holds based on
your invoice approval needs.
You can manually apply one or more Invoice Hold
Reason holds to an invoice using the Invoice Holds
window of the Invoice Workbench.

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Holds >
Applying Holds scroll down to Applying a Hold to an Invoice
(N) Setup > Invoice > Approvals
(N) Invoices > Entry > Invoices (B) Holds



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Managing and Approving Invoices
Chapter 4 - Page 21

Applying Holds to Suppliers

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Applying Holds to SuppliersApplying Holds to Suppliers

You can prevent payment of supplier invoices by
applying a hold to the supplier site.

In the Supplier Sites window, you can enable these
options:
• Hold All Payments
• Hold Unapproved Invoices
• Hold Unmatched Invoices

• Hold All Payments
• Hold Unapproved Invoices
• Hold Unmatched Invoices
You can also specify an invoice amount limit for a
supplier site.

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Holds >
Applying Holds scroll down to Applying Supplier Site Holds
(N) Suppliers > Entry (M) View > Find (B) Sites (T) Control
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Applying Holds to Scheduled Payments
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Applying Holds to Scheduled PaymentsApplying Holds to Scheduled Payments

You can hold payment on an invoice, or on part of an
invoice, by placing one or more of the scheduled
payments on hold in the Scheduled Payments
window of the Invoice Workbench.

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Holds >
Applying Holds scroll down to Applying a Hold to a Scheduled Payment
(N) Invoices > Entry > Invoices (B) Scheduled Payments
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DemonstrationDemonstration

This demonstration covers how to manually apply a
hold to an invoice.

(N) Invoices > Entry > Invoices (B) Holds
(N) Suppliers > Entry (M) View > Find (B) Sites
(T) Control
(N) Invoices > Entry > Invoices (B) Scheduled
Payments
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Releasing Invoice Holds
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Releasing Invoice HoldsReleasing Invoice Holds

• Release holds from invoices to pay and account
for them.

• You can view the holds on an invoice in either the
Invoice Overview or the Invoice Holds window.
You can see the number of holds on an invoice in
the Invoices window.

• Identify invoices on hold with the Invoices on Hold
Report and the Matching Hold Detail Report.

• Release holds from invoices to pay and account
for them.

• You can view the holds on an invoice in either the
Invoice Overview or the Invoice Holds window.
You can see the number of holds on an invoice in
the Invoices window.

• Identify invoices on hold with the Invoices on Hold
Report and the Matching Hold Detail Report.

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Holds > Releasing Holds > Releasing Holds
(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Appendix > Using Oracle Alert for Exception Reporting
(N) Invoices > Entry > Invoices (M) View > Find (B) Holds
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Correcting System Holds
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Correcting System HoldsCorrecting System Holds

• Oracle Payables applies some holds that you
cannot manually release.

• You can use the Invoice Holds window to view
invoices with system holds, but you cannot
manually release these holds.

• You can correct exceptions by updating either the
invoice or the purchase order, or by changing your
invoice tolerances.

• You must correct the exception that caused
Approval to place the hold on the invoice and then
resubmit Approval to release system holds.

• Oracle Payables applies some holds that you
cannot manually release.

• You can use the Invoice Holds window to view
invoices with system holds, but you cannot
manually release these holds.

• You can correct exceptions by updating either the
invoice or the purchase order, or by changing your
invoice tolerances.

• You must correct the exception that caused
Approval to place the hold on the invoice and then
resubmit Approval to release system holds.

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Holds > Releasing Holds >
Hold Release Restrictions
(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Setup > Invoice Approvals > Invoice Approvals
(N) Invoices > Entry > Invoices (M) View > Find (B) Holds
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Manually Releasing Holds
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Manually Releasing HoldsManually Releasing Holds

You can manually release three types of holds:
• Invoice Hold

– In the Invoice Holds window, select a Release
Name

– In the Invoice Actions window, select Release
Holds

You can manually release three types of holds:
• Invoice Hold

– In the Invoice Holds window, select a Release
Name

– In the Invoice Actions window, select Release
Holds

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Holds > Releasing Holds > Releasing Holds
(N) Invoices > Entry > Invoices (M) View > Find (B) Holds
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Manually Releasing Holds
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Manually Releasing HoldsManually Releasing Holds

• Supplier Site Hold
– In the Invoice Holds window, release the holds

that resulted from the Hold Unapproved
Invoices option, the Hold Unmatched Invoices
option, and the Invoice Amount Limit (Amount
Hold)

– In the Supplier Sites window, uncheck the
Hold All Payments option to release this hold

• Scheduled Payment Hold
– In the Scheduled Payments window, uncheck

the Hold check box

• Supplier Site Hold
– In the Invoice Holds window, release the holds

that resulted from the Hold Unapproved
Invoices option, the Hold Unmatched Invoices
option, and the Invoice Amount Limit (Amount
Hold)

– In the Supplier Sites window, uncheck the
Hold All Payments option to release this hold

• Scheduled Payment Hold
– In the Scheduled Payments window, uncheck

the Hold check box

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Holds > Releasing Holds > Releasing Holds
(N) Invoices > Entry > Invoices (M) View > Find (B) Holds
(N) Suppliers > Entry (M) View > Find (B) Sites (T) Control
(N) Invoices > Entry > Invoices (B) Scheduled Payments
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Manually Releasing System Holds
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Acct Hold Reason           No

Funds Hold Reason          Mixed

Insufficient Information          No

Invoice Hold Reason                  Mixed

Matching Hold Reason          Mixed

Period Hold Type                  No

PO Req Hold Reason             No

Variance Hold Reason          Mixed

Manually Releasing System HoldsManually Releasing System Holds

Review the hold types that are manually releasable.Review the hold types that are manually releasable.
User Manually

 Hold Types Predefined Definable Releasable

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Setup > Invoice Approvals > Invoice Approvals
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Manually Releasing System Holds
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Manually Releasing System HoldsManually Releasing System Holds

If you release a manually releasable hold that Oracle
Payables applied during Approval, the next time you
submit Approval, Oracle Payables will not reapply the
same hold.

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Holds > Releasing Holds > Releasing Holds
(N) Invoices > Entry > Invoices (M) View > Find (B) Holds
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Releasing Invoice Holds
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Releasing Invoice HoldsReleasing Invoice Holds

Define your release codes in the Invoice Approvals
window. Define as many release codes as you need.

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Setup > Invoice Approvals > Invoice Approvals
(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Holds > Releasing Holds >
Releasing Holds
(N) Setup > Invoice > Approvals
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Releasing Holds
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Acct Release Reason           

Funds Release Reason          

Sufficient Information          

Invoice Release Reason                  

Matching Release Reason          

Period Release Type                  

Variance Release Reason             

Hold Quick Release Reason

Invoice Quick Release Reason          

Releasing HoldsReleasing Holds
Review the predefined release types that Oracle PayablesReview the predefined release types that Oracle Payables
provides.provides.

Approval                            User 
Release Types Predefined          Definable

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Setup > Invoice Approvals > Invoice Approvals
(N) Setup > Invoice > Approvals



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Managing and Approving Invoices
Chapter 4 - Page 32

Review Question

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Review QuestionReview Question

If you have an invoice that Oracle Payables put on
hold because of an account hold reason, you must
correct the problem and then resubmit Approval.
True or False?
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Review Question Solution
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Review Question SolutionReview Question Solution

If you have an invoice that Oracle Payables put on
hold because of an account hold reason, you must
correct the problem and then resubmit Approval.
True or False?
Answer:
True
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Demonstration
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DemonstrationDemonstration

This demonstration covers how to release a hold on
an invoice.

(N) Invoices > Entry > Invoices (M) View > Find
(B) Holds
(N) Suppliers > Entry (M) View > Find (B) Sites
(T) Control
(N) Invoices > Entry > Invoices (B) Scheduled
Payments
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Agenda
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AgendaAgenda

• Inquiring on invoices
• Applying and releasing holds
• Approving invoices
• Adjusting or canceling invoices
• Adjusting purchase order matched invoices

• Inquiring on invoices
• Applying and releasing holds
• Approving invoices
• Adjusting or canceling invoices
• Adjusting purchase order matched invoices
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Approving Invoices: Overview
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Approving Invoices: OverviewApproving Invoices: Overview

After completing this section, you should be able to:
• Describe the various approval methods
• Submit invoices for batch approval
• Approve invoices online
• Approve invoice batches online

After completing this section, you should be able to:
• Describe the various approval methods
• Submit invoices for batch approval
• Approve invoices online
• Approve invoice batches online
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Approving Invoices: Overview

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Approving Invoices: OverviewApproving Invoices: Overview
Enter or importEnter or import
invoicesinvoices

Approve invoice

OptionallyOptionally
match to POmatch to PO

or receiptor receipt

CreateCreate
accountingaccounting

View invoiceView invoice

Pay invoicePay invoice

Receive invoicesReceive invoices
electronically orelectronically or

in the mailin the mail

100,000100,000

APAP

60,00060,000
10,00010,000
30,00030,000

Approve invoiceApprove invoice
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Approving Invoices
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Approving InvoicesApproving Invoices

Before you can pay or account for an invoice
(including prepayments), you must submit Approval
for the invoice in one of three ways:
• Batch by submitting the Payables Approval

program from the Submit Request window
• Online by using the Invoice Actions window
• Online by using the Approve button in the Invoice

Batches window

Before you can pay or account for an invoice
(including prepayments), you must submit Approval
for the invoice in one of three ways:
• Batch by submitting the Payables Approval

program from the Submit Request window
• Online by using the Invoice Actions window
• Online by using the Approve button in the Invoice

Batches window

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Approval > Approval
(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Approval > Payables Approval Program
(N) Other > Requests > Run
(N) Invoices > Entry > Invoices (M) View > Find (B) Actions
(N) Invoices > Entry > Invoices Batches (B) Approve
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Approving Invoices
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Approving InvoicesApproving Invoices

• Approval validates the matching, tax, period
status, exchange rate, and distribution information
for invoices that you enter.

• Approval automatically applies holds to exception
invoices.

• If a tax, freight, or miscellaneous distribution is
not allocated or not fully allocated, Approval fully
allocates the distribution by prorating across all
applicable distributions.

• Approval validates the matching, tax, period
status, exchange rate, and distribution information
for invoices that you enter.

• Approval automatically applies holds to exception
invoices.

• If a tax, freight, or miscellaneous distribution is
not allocated or not fully allocated, Approval fully
allocates the distribution by prorating across all
applicable distributions.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Managing and Approving Invoices
Chapter 4 - Page 40

Submitting Batch Approval
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Submitting Batch ApprovalSubmitting Batch Approval

You can automate your approval cycle through
automatic approval resubmission.

Define your submission options for the Payables
Approval program in the Submit Request window.

You can specify the intervals when you want to
submit Approval, and Payables will submit Approval
using the parameters you specify.

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Approval > Approval
(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Approval > Payables Approval Program
(N) Other > Requests > Run
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Submitting Batch Approval
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Submitting Batch ApprovalSubmitting Batch Approval

• Enter All in the Option field to submit Approval
for all invoices. Otherwise, Approval reviews
only those invoice distributions that were not
already reviewed by Approval.

• Optionally, enter other criteria to submit
Approval for specific groups of invoices.

• Enter All in the Option field to submit Approval
for all invoices. Otherwise, Approval reviews
only those invoice distributions that were not
already reviewed by Approval.

• Optionally, enter other criteria to submit
Approval for specific groups of invoices.

In the Submit Request window, select Payables
Approval and enter the parameters of your choice:

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Approval > Approval
(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Approval > Payables Approval Program
(N) Other > Requests > Run
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Approving Invoices Online
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Approving Invoices OnlineApproving Invoices Online

If the Payables option to allow online approval is
enabled, you can submit online approval for
individual invoices when an invoice must be
approved and paid immediately.

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Approval >
Submitting Online Approval for Invoices
(N) Invoices > Entry > Invoices (M) View > Find (B) Actions
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Demonstration
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DemonstrationDemonstration

This demonstration covers how to approve an
invoice.

(N) Other > Requests > Run
(N) Invoices > Entry > Invoices (M) View > Find
(B) Actions
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Approving Invoice Batches Online
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Approving Invoice Batches OnlineApproving Invoice Batches Online

Submit Approval for entire batches from the Invoice
Batches window.

Use the multi-row selection feature to select several
batches to approve at the same time.

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Approval >
Submitting Online Approval for Invoice Batches
(N) Invoices > Entry > Invoice Batches (M) View > Find (B) Approve
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Practice 1
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Practice 1Practice 1

In this practice, you will answer questions about
approving invoices.
1.  To allow online approval, enable the ______

Payables option.
2.  To approve invoices online from the Invoices

window, click the ______ button.
3.  Submit Approval for entire batches from the

______ window.
4.  You can set up automatic submission of the

Payables Approval program in the ______ window.

In this practice, you will answer questions about
approving invoices.
1.  To allow online approval, enable the ______

Payables option.
2.  To approve invoices online from the Invoices

window, click the ______ button.
3.  Submit Approval for entire batches from the

______ window.
4.  You can set up automatic submission of the

Payables Approval program in the ______ window.
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Practice 1 Solutions
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Practice 1 SolutionsPractice 1 Solutions

In this practice, you will answer questions about
approving invoices.
1.  To allow online approval, enable the Allow Online

Approval Payables option.
2.  To approve invoices online from the Invoices

window, click the Actions button.
3.  Submit Approval for entire batches from the

Invoice Batches window.
4.  You can set up automatic submission of the

Payables Approval program in the Submit Request
window.

In this practice, you will answer questions about
approving invoices.
1.  To allow online approval, enable the Allow Online

Approval Payables option.
2.  To approve invoices online from the Invoices

window, click the Actions button.
3.  Submit Approval for entire batches from the

Invoice Batches window.
4.  You can set up automatic submission of the

Payables Approval program in the Submit Request
window.
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Agenda
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AgendaAgenda

• Inquiring on invoices
• Applying and releasing holds
• Approving invoices
• Adjusting or canceling invoices
• Adjusting purchase order matched invoices

• Inquiring on invoices
• Applying and releasing holds
• Approving invoices
• Adjusting or canceling invoices
• Adjusting purchase order matched invoices
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Other Invoice Functions: Overview
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Other Invoice Functions: OverviewOther Invoice Functions: Overview

After completing this section, you should be able to:
• Adjust invoices
• Cancel invoices

After completing this section, you should be able to:
• Adjust invoices
• Cancel invoices
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Adjusting Invoices
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Adjusting InvoicesAdjusting Invoices

• Authorized users can make adjustments to invoice
details, distributions, and scheduled payments,
even if the invoice has been accounted or paid

• You can adjust certain information on a paid
invoice if you enable the Allow Adjustments to
Paid Invoices Payables option

• Authorized users can make adjustments to invoice
details, distributions, and scheduled payments,
even if the invoice has been accounted or paid

• You can adjust certain information on a paid
invoice if you enable the Allow Adjustments to
Paid Invoices Payables option

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Adjusting Invoices >
Adjusting Invoice Amounts scroll down to Adjusting Invoice Amounts
(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Adjustment Charts > Invoice Adjustment Chart
(N) Invoices > Entry > Invoices (M) View > Find
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Demonstration
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DemonstrationDemonstration

This demonstration covers how to adjust an invoice.
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Canceling Invoices
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Canceling InvoicesCanceling Invoices

• You can cancel only unpaid invoices
• You can cancel any unapproved invoice or an

approved invoice that does not have any effective
payments or accounting holds

• If an invoice has a hold that prevents accounting,
you must release the hold before you cancel the
invoice

• You cannot cancel an invoice that was selected for
payment in a payment batch

• You can cancel only unpaid invoices
• You can cancel any unapproved invoice or an

approved invoice that does not have any effective
payments or accounting holds

• If an invoice has a hold that prevents accounting,
you must release the hold before you cancel the
invoice

• You cannot cancel an invoice that was selected for
payment in a payment batch

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Adjusting Invoices > Canceling Invoices
(N) Invoices > Entry > Invoices (M) View > Find (B) Actions
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Demonstration
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DemonstrationDemonstration

This demonstration covers how to cancel an invoice.
(N) Invoices > Entry > Invoices (M) View > Find
(B) Actions
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Agenda
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AgendaAgenda

• Inquiring on invoices
• Applying and releasing holds
• Approving invoices
• Adjusting or canceling invoices
• Adjusting purchase order matched invoices

• Inquiring on invoices
• Applying and releasing holds
• Approving invoices
• Adjusting or canceling invoices
• Adjusting purchase order matched invoices



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Managing and Approving Invoices
Chapter 4 - Page 54

Adjusting Purchase Order Matched Invoices: Overview
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Adjusting Purchase Order Matched
Invoices: Overview

Adjusting Purchase Order Matched
Invoices: Overview

After completing this section, you should be able to:
• Identify and resolve matching issues
• Adjust purchase order matched invoices

After completing this section, you should be able to:
• Identify and resolve matching issues
• Adjust purchase order matched invoices
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Matching Invoices to Purchase Orders
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Matching Invoices to Purchase OrdersMatching Invoices to Purchase Orders
Enter or importEnter or import
invoicesinvoices

Approve invoice

OptionallyOptionally
match to POmatch to PO

or receiptor receipt

CreateCreate
accountingaccounting

View invoiceView invoice

Pay invoicePay invoice

Receive invoicesReceive invoices
electronically orelectronically or

in the mailin the mail

100,000100,000

APAP

60,00060,000
10,00010,000
30,00030,000

Approve invoiceApprove invoice
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Matching Invoices to Purchase Orders and Receipts
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Matching Invoices to Purchase Orders
and Receipts

Matching Invoices to Purchase Orders
and Receipts

Oracle Payables ensures that you match within the
amount and quantity tolerances that you have set. If
the match is not within the tolerances, Payables
applies a hold to the invoice.

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Setup > Invoice Tolerances
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Resolving Matching Issues
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Resolving Matching IssuesResolving Matching Issues

• Submit the Matching Hold Detail Report to review
detailed accounts payable and purchasing
information for invoices with matching holds and
matching hold releases

• Submit the Invoices on Hold Report to identify
which invoices are on hold and to obtain detailed
information regarding those invoices

• Submit the Matching Hold Detail Report to review
detailed accounts payable and purchasing
information for invoices with matching holds and
matching hold releases

• Submit the Invoices on Hold Report to identify
which invoices are on hold and to obtain detailed
information regarding those invoices

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Reports and Programs > Invoice Reports >
Matching Hold Details Report
(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Finding and Reviewing Invoices >
Reviewing Invoices
(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Reports and Programs > Invoice Reports >
Invoice on Hold Report
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Adjusting Purchase Order Matched Invoices
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Adjusting Purchase Order Matched
Invoices

Adjusting Purchase Order Matched
Invoices

• Reverse matched distributions
• Create new invoice distributions by matching to

new purchase order shipments, or to distributions
of the same or another purchase order

• Adjust the GL Date, Income Tax Type, and
Account fields of a purchase order matched
invoice distribution

• Record a price correction

• Reverse matched distributions
• Create new invoice distributions by matching to

new purchase order shipments, or to distributions
of the same or another purchase order

• Adjust the GL Date, Income Tax Type, and
Account fields of a purchase order matched
invoice distribution

• Record a price correction

Adjust purchase order matched invoices:

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices >
Adjusting Invoices scroll down to Adjusting Purchase Order Matched Invoices
(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Adjusting Invoices >
Adjusting Invoice Distributions scroll down to Reversing Invoice Distributions
(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Adjustment Charts > Invoice Adjustment Chart
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Adjusting Purchase Order Matched Invoices
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Adjusting Purchase Order Matched
Invoices

Adjusting Purchase Order Matched
Invoices

If you add or reverse distributions, you must also
change the scheduled payment amounts to match the
new invoice total.
If you do not change the scheduled payment amounts
to match the new invoice total, Payables will place a
hold on the invoice during Approval.

(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices >
Adjusting Invoices scroll down to Adjusting Purchase Order Matched Invoices
(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Adjusting Invoices >
Adjusting Invoice Distributions scroll down to Reversing Invoice Distributions
(Help) Applications Help Library > Oracle Financial Applications >
Oracle Payables > Invoices > Adjustment Charts > Invoice Adjustment Chart
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Review QuestionReview Question

1.  Reverse a distribution
2.  Add a distribution
3.  Record a price correction
4.  Adjust the GL Date of a purchase order matched

distribution
5.  All of the above

1.  Reverse a distribution
2.  Add a distribution
3.  Record a price correction
4.  Adjust the GL Date of a purchase order matched

distribution
5.  All of the above

To adjust a purchase order matched invoice, you can:
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Review Question Solution
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Review Question SolutionReview Question Solution

1.  Reverse a distribution
2.  Add a distribution
3.  Record a price correction
4.  Adjust the GL Date of a purchase order matched

distribution
5.  All of the above

1.  Reverse a distribution
2.  Add a distribution
3.  Record a price correction
4.  Adjust the GL Date of a purchase order matched

distribution
5.  All of the above

To adjust a purchase order matched invoice, you can:
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Lesson SummaryLesson Summary

In this lesson, you should have learned how to:
• Inquire on invoices
• Apply and release holds
• Approve invoices
• Adjust or cancel invoices
• Adjust purchase order matched invoices

In this lesson, you should have learned how to:
• Inquire on invoices
• Apply and release holds
• Approve invoices
• Adjust or cancel invoices
• Adjust purchase order matched invoices
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Matching Invoices to
Purchase Orders and
Receipts
Chapter 5
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Matching Invoices to Purchase Orders and Receipts
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Matching Invoices to Purchase Orders
and Receipts

Matching Invoices to Purchase Orders
and Receipts

Oracle Payables R11iOracle Payables R11i
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ObjectivesObjectives

After completing this lesson, you should be able to
do the following:
• Describe the basics of matching invoices to

purchase orders and receipts.
• Explain how to match Standard invoices to

purchase orders and receipts using the Invoice
Workbench.

• Explain how to match QuickMatch and PO Default
type invoices to purchase orders and receipts in
the Invoice Workbench.

• Explain how to match invoices to purchase orders
and receipts using the Invoice Gateway.

After completing this lesson, you should be able to
do the following:
• Describe the basics of matching invoices to

purchase orders and receipts.
• Explain how to match Standard invoices to

purchase orders and receipts using the Invoice
Workbench.

• Explain how to match QuickMatch and PO Default
type invoices to purchase orders and receipts in
the Invoice Workbench.

• Explain how to match invoices to purchase orders
and receipts using the Invoice Gateway.
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Agenda
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AgendaAgenda

• Overview of matching invoices to purchase orders
and receipts

• Matching Standard invoices to purchase orders
and receipts using the Invoice Workbench

• Matching QuickMatch and PO Default type
invoices to purchase orders and receipts in the
Invoice Workbench

• Matching invoices to purchase orders and receipts
using the Invoice Gateway

• Overview of matching invoices to purchase orders
and receipts

• Matching Standard invoices to purchase orders
and receipts using the Invoice Workbench

• Matching QuickMatch and PO Default type
invoices to purchase orders and receipts in the
Invoice Workbench

• Matching invoices to purchase orders and receipts
using the Invoice Gateway
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Entering Purchase Order Matched Invoices : Overview
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 Entering Purchase Order Matched
Invoices : Overview

 Entering Purchase Order Matched
Invoices : Overview

Receive invoiceReceive invoice Enter invoiceEnter invoice

Approve invoiceApprove invoice

Match invoices
to PO or receipt

File invoiceFile invoice
Account forAccount for

invoiceinvoice

View invoiceView invoice

Pay invoicePay invoice
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Detail

The Structure of a Purchase OrderThe Structure of a Purchase Order
Purchase OrderPurchase Order

Header

Item line

Item line

Item line

Distribution line
Shipment line

PO information Supplier information

Shipment line
Distribution line
Distribution line
Distribution line
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The Structure of a Receipt
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Detail

The Structure of a ReceiptThe Structure of a Receipt
ReceiptReceipt

Header

Receipt
 information

Receipt Line Information

Shipment
 information

Supplier
 information
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Purchase Order Matched Invoices
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Purchase Order Matched InvoicesPurchase Order Matched Invoices

• Purchase order shipments
• Purchase order receipts
• Purchase order receipt lines
• Purchase order distributions

• Purchase order shipments
• Purchase order receipts
• Purchase order receipt lines
• Purchase order distributions

Purchase order matched invoices are invoices that youPurchase order matched invoices are invoices that you
match to any of the following:match to any of the following:
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Why Enter Purchase Order Matched
Invoices?

Why Enter Purchase Order Matched
Invoices?

• Match Payables invoices to purchase orders to
ensure that you pay only for the goods that you
have ordered.

• Match to purchase order receipts to ensure that
you pay only for goods that you have received.

• Payables automatically creates invoice
distributions based on the purchase order
distributions.

• Match Payables invoices to purchase orders to
ensure that you pay only for the goods that you
have ordered.

• Match to purchase order receipts to ensure that
you pay only for goods that you have received.

• Payables automatically creates invoice
distributions based on the purchase order
distributions.

(Help) Oracle Financial Applications > Payables > Invoices > Matching to
Purchase Orders and Receipts > Entering Purchase Order Matched Invoices
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You Can Set Up Controls That Require You To Do The
Following:
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You Can Set Up Controls That Require
You To Do The Following:

You Can Set Up Controls That Require
You To Do The Following:

• Purchase order match each invoice
• Match the invoice to either a purchase order or

receipt
• Match within amount or quantity tolerances

• Purchase order match each invoice
• Match the invoice to either a purchase order or

receipt
• Match within amount or quantity tolerances
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Matching ProcessMatching Process

Save Invoice

Select purchase order or receipt and choose Match

Enter supplier information

Enter invoice date, number, and amount

Complete CompleteComplete

If matching to PO distribution, choose Distribution
and enter distribution quantity or match amount

Enter invoice quantity and match amount

Enter additional invoice header information

Enter purchase order number

Select purchase order or receipt

Option A: Standard, Expense Report, 
Mixed, Prepayment, Credit Memo,

Debit Memo

Option B:
PO Default

Option C:
QuickMatch
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Different Ways to Match an Invoice to a Purchase
Order
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Different Ways to Match an Invoice to a
Purchase Order

Different Ways to Match an Invoice to a
Purchase Order

• Receipt match
• Purchase order shipment match
• Purchase order distribution match
• Price correction

• Receipt match
• Purchase order shipment match
• Purchase order distribution match
• Price correction

You can match an invoice to a purchase order in differentYou can match an invoice to a purchase order in different
ways:ways:
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Receipt Match
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Receipt MatchReceipt Match

• Matching to receipts allows you to pay only for
goods you receive, and to pay for partial
shipments without getting invoice holds.

• Any exchange rate variance is likely to be smaller
because the time between the receipt and invoice
is less  than the time between the purchase order
and invoice.

• Matching an invoice for freight, tax, or
miscellaneous charges to a material receipt is
required for accurate costing data if you use
periodic costing.

• Matching to receipts allows you to pay only for
goods you receive, and to pay for partial
shipments without getting invoice holds.

• Any exchange rate variance is likely to be smaller
because the time between the receipt and invoice
is less  than the time between the purchase order
and invoice.

• Matching an invoice for freight, tax, or
miscellaneous charges to a material receipt is
required for accurate costing data if you use
periodic costing.
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Purchase Order Shipment Match
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Purchase Order Shipment MatchPurchase Order Shipment Match

     Based on the Quantity Invoiced, Payables prorates
the Match Amount across all non-fully billed
purchase order distributions associated with the
purchase order shipments you match to.

     Based on the Quantity Invoiced, Payables prorates
the Match Amount across all non-fully billed
purchase order distributions associated with the
purchase order shipments you match to.
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Purchase Order Distribution Match
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Purchase Order Distribution MatchPurchase Order Distribution Match

    You can allocate the match amount to specific
purchase order distributions.

    You can allocate the match amount to specific
purchase order distributions.
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Price Corrections
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Price CorrectionsPrice Corrections

• You can use a price correction when a supplier
sends an invoice for a change in unit price for an
invoice you have already matched to a purchase
order.

• You can enter and match an invoice to record a
price increase, or you can enter and match a credit
memo or debit memo to record a price decrease.

• Use a price correction to adjust the invoiced unit
price of previously matched purchase order
shipments, distributions, or receipts without
adjusting the quantity billed.

• You can use a price correction when a supplier
sends an invoice for a change in unit price for an
invoice you have already matched to a purchase
order.

• You can enter and match an invoice to record a
price increase, or you can enter and match a credit
memo or debit memo to record a price decrease.

• Use a price correction to adjust the invoiced unit
price of previously matched purchase order
shipments, distributions, or receipts without
adjusting the quantity billed.

(Help) Oracle Financial Applications > Payables > Invoices > Matching to
Purchase Orders and Receipts > Recording Price Corrections in the Invoice
Workbench



Copyright © Oracle Corporation, 2000. All rights reserved.

Matching Invoices to Purchase Orders and Receipts
Chapter 5 - Page 17

Agenda

Copyright  Oracle Corporation, 2000. All rights reserved.
®

AgendaAgenda

• Overview of matching invoices to purchase orders
and receipts

• Matching Standard invoices to purchase orders
and receipts using the Invoice Workbench

• Matching QuickMatch and PO Default type
invoices to purchase orders and receipts in the
Invoice Workbench

• Matching invoices to purchase orders and receipts
using the Invoice Gateway

• Overview of matching invoices to purchase orders
and receipts

• Matching Standard invoices to purchase orders
and receipts using the Invoice Workbench

• Matching QuickMatch and PO Default type
invoices to purchase orders and receipts in the
Invoice Workbench

• Matching invoices to purchase orders and receipts
using the Invoice Gateway
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Practice Overview
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Practice OverviewPractice Overview

Practice Contents:
• Enter and approve a purchase order
• Enter the receiving for the PO Shipments
• Match an invoice to a purchase order in the Invoice

Workbench
• Match an invoice to a receipt

Practice Contents:
• Enter and approve a purchase order
• Enter the receiving for the PO Shipments
• Match an invoice to a purchase order in the Invoice

Workbench
• Match an invoice to a receipt

Practice Solution
Enter and Approve a Purchase Order

1. Change your responsibility to Oracle Purchasing:
• (M) File—>Switch Responsibility—>Purchasing, Vision Operations

(USA)
• Navigate to the Enter Purchase Orders window.
• (N) Purchase Orders—Purchase Orders
• Enter Standard Purchase Order in the Type field.
• Enter Advanced Network Devices in the Supplier field and the site

should default in.
• Place your cursor on the first line and tab to the Item field,

accepting the defaults for the first two fields. Enter item number
AS18947.

• Enter 10 in the Quantity field.
• Choose the Shipments button. This will take you to the Shipments

window.
• Change the quantity from 10 to 6 on the first line.
• Enter a date five days from today’s date in the Promised field.
• Select the More tab.
• Select 2-Way in the Match Approval Level field.
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• Select PO in the Invoice Match Option field.
• Select the Shipments tab.
• Click the second line.
• The four remaining units should default in the second shipment line.
• Enter a date five days from today’s date in the Promised field.
• Select the More tab.
• Select 3-Way in the Match Approval Level field.
• Select Receipt in the Invoice Match Option field.
• Save your work.
• Close the Shipments window.
• Click the Approve button.
• You should see the Approve Document window.
• Click OK.
• You should see a message.
• Click OK to acknowledge the message.
• Verify the Status field on your PO shows Approved.
• Write down your PO number _____________.
• Write down the Ship-To organization ____________.
2. Enter the Receiving for the PO Shipments
• Navigate to the Find Expected Receipts window. (N) Receiving—

>Receipts
• Select the Ship-To organization from the previous step.
• Enter your PO number in the Purchase Order field.
• Click the Find button. This will take you to the Receipt Header

window.
• Close the Receipt Header window and you will be in the Lines

window.
• Select the box to the left of the each line, to indicate the quantities

have been received.
• Save your work.
• Select the Header button and this will take you back to the Receipt

Header window.
• Write down your receipt number ____________.
3. Match an Invoice to a Purchase Order
• Change your responsibility to Oracle Payables:(M) File—> Switch

Responsibility—> Payables, Vision Operations (USA)
• Navigate to the Invoice Workbench (N) Invoices—>Entry—

>Invoices
• Enter Standard in the Invoice Type field.
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• Enter Advanced Network Devices in the Supplier Name field. The
site should default in.

• Enter today’s date as the invoice date.
• Enter the invoice number.
• Enter 7,247.16 in the Invoice Amount field.
• Set the Match Option to Purchase Order and select the Match

button. This opens the Find Purchase Orders for Matching window.
Notice that this new window has been enhanced to include 10
search criteria fields.

• Enter your purchase order from step 1 and select the Find button.
• The new Match to Purchase Orders window opens.
• Select the line that corresponds to PO shipment 1.
• The Quantity Invoiced field should default to 6.
• The Unit Price field should default to 1207.86.
•  Select the Match button to complete the matching process.
4.Match an Invoice to a Receipt
• Navigate to the Invoice Workbench: (N) Invoices—>Entry—

>Invoices
• Enter Standard in the Invoice Type field.
• Enter Advanced Network Devices in the Supplier Name field. The

site should default in.
• Enter today’s date as the invoice date.
• Enter the invoice number.
• Enter 4,831.44 in the Invoice Amount field.
• Verify the Match option is set to Receipt and select the Match

button. This will take you to the Find Receipts for Matching window.
− Note: In the Find Receipts for Matching window, certain fields

are dependent on other fields. For example, entering a valid
PO number will result in only receipts for that PO appearing in
the receipt number LOV. If no PO number is entered, the
receipt number LOV will show all receipts for the supplier on
the invoice. In the Find Receipts for Matching window you
have several ways of retrieving the receipt to which you want
to match. You can enter any combination or single entry of the
PO number, receipt number, or packing slip number.

• Enter your receipt number then click Find. This will take you to the
Match to Receipts window.

− Note: When the Match to Receipts window opens, notice that
you can see both PO shipments, even though the match
option on shipment 1 is Match to Purchase Order. You will see
all shipments meeting the search criteria entered in the Find
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window,regardless of the match option. This gives a complete
view of the lines entered on that receipt.

• Select the Match check box to indicate you have been billed for all
four units on PO shipment 2.

• Select the Match button. The invoice has now been matched to the
receipt.
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Review Question
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Review QuestionReview Question

1. Standard invoice
2. Mixed invoice
3. PO Default invoice
4. Expense Report invoice
5. QuickMatch invoice
6. None of the above

1. Standard invoice
2. Mixed invoice
3. PO Default invoice
4. Expense Report invoice
5. QuickMatch invoice
6. None of the above

Which invoice type can you not match to purchase orders
and receipts?
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Answer to Review Question
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Answer to Review QuestionAnswer to Review Question

1. Standard invoice
2. Mixed invoice
3. PO Default invoice
4. Expense Report invoice
5. QuickMatch invoice
6. None of the above

1. Standard invoice
2. Mixed invoice
3. PO Default invoice
4. Expense Report invoice
5. QuickMatch invoice
6. None of the above

Which invoice type can you not match to purchase orders
and receipts?
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Agenda
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AgendaAgenda

• Overview of matching invoices to purchase orders
and receipts

• Matching Standard invoices to purchase orders
and receipts using the Invoice Workbench

• Matching QuickMatch and PO default invoices to
purchase orders and receipts in the Invoice
Workbench

• Matching invoices to purchase orders and receipts
using the Invoice Gateway

• Overview of matching invoices to purchase orders
and receipts

• Matching Standard invoices to purchase orders
and receipts using the Invoice Workbench

• Matching QuickMatch and PO default invoices to
purchase orders and receipts in the Invoice
Workbench

• Matching invoices to purchase orders and receipts
using the Invoice Gateway
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PO Default and QuickMatch Invoices
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PO Default and QuickMatch InvoicesPO Default and QuickMatch Invoices

• If you have the amount of the purchase order to
which you want to match, Payables provides you
with two invoice types, PO Default and
QuickMatch, to help speed up invoice matching.

• Enter PO Default as the invoice type if you know
the purchase order you want to match to, but
you do not know to which purchase order
shipments or distributions you want to match.

• Enter QuickMatch as the invoice type if you want
to match an invoice to all shipments or receipt
lines on a purchase order.

• If you have the amount of the purchase order to
which you want to match, Payables provides you
with two invoice types, PO Default and
QuickMatch, to help speed up invoice matching.

• Enter PO Default as the invoice type if you know
the purchase order you want to match to, but
you do not know to which purchase order
shipments or distributions you want to match.

• Enter QuickMatch as the invoice type if you want
to match an invoice to all shipments or receipt
lines on a purchase order.
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Demonstration of Matching QuickMatch and PO Default
type Invoices to Receipts and Purchase Orders
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Demonstration of Matching QuickMatch
and PO Default type Invoices to Receipts

and Purchase Orders

Demonstration of Matching QuickMatch
and PO Default type Invoices to Receipts

and Purchase Orders

The instructor will demonstrate how to match
QuickMatch and PO Default type invoices to receipts
and purchase orders in the Invoice Workbench.
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Review QuestionReview Question

1. True
2. False
1. True
2. False

If you enter a QuickMatch type invoice, Payables
automatically completes the match to all purchase order
shipments.



Copyright © Oracle Corporation, 2000. All rights reserved.

Matching Invoices to Purchase Orders and Receipts
Chapter 5 - Page 28

Answer to Review Question
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Answer to Review QuestionAnswer to Review Question

1. True
2. False
1. True
2. False

If you enter a QuickMatch type invoice, Payables
automatically completes the match to all purchase order
shipments.
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Agenda
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AgendaAgenda

• Overview of matching invoices to purchase orders
and receipts

• Matching invoices to purchase orders and receipts
using the Invoice Workbench

• Matching QuickMatch and PO Default type
invoices to purchase orders and receipts

• Matching invoices to purchase orders and receipts
using the Invoice Gateway

• Overview of matching invoices to purchase orders
and receipts

• Matching invoices to purchase orders and receipts
using the Invoice Workbench

• Matching QuickMatch and PO Default type
invoices to purchase orders and receipts

• Matching invoices to purchase orders and receipts
using the Invoice Gateway
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Entering Purchase Order Matched Invoice Records in
the Invoice Gateway
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Entering Purchase Order Matched Invoice
Records in the Invoice Gateway

Entering Purchase Order Matched Invoice
Records in the Invoice Gateway

• When you enter a purchase order matched
invoice record, the import process automatically
creates invoice distributions for you based on
your match.

• You can match to a purchase order receipt, and
you can match to a purchase order at different
levels:  purchase order header, purchase order
line, purchase order shipment, purchase order
distribution.

• You can match only Standard and Credit Memo
type invoices in the Invoice Gateway.

• When you enter a purchase order matched
invoice record, the import process automatically
creates invoice distributions for you based on
your match.

• You can match to a purchase order receipt, and
you can match to a purchase order at different
levels:  purchase order header, purchase order
line, purchase order shipment, purchase order
distribution.

• You can match only Standard and Credit Memo
type invoices in the Invoice Gateway.
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Demonstration of How to Match Invoices to Purchase
Orders and Receipts in the Invoice Gateway
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Demonstration of How to Match Invoices
to Purchase Orders and Receipts in the

Invoice Gateway

Demonstration of How to Match Invoices
to Purchase Orders and Receipts in the

Invoice Gateway

The instructor will demonstrate how to match
invoices to purchase orders and receipts in the
Invoice Gateway.
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Review QuestionReview Question

1. True
2. False
1. True
2. False

When you enter a purchase order matched invoice
record, the import process automatically creates
invoice distributions for you based on your match.
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Answer to Review Question
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Answer to Review QuestionAnswer to Review Question

1. True
2. False
1. True
2. False

When you enter a purchase order matched invoice
record, the import process automatically creates
invoice distributions for you based on your match.
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SummarySummary

In this lesson, you should have learned how to:
• describe the basics of matching invoices to

purchase orders and receipts
• match invoices to purchase orders and receipts

using the Invoice Workbench
• match QuickMatch and PO Default type invoices to

purchase orders and receipts
• match invoices to purchase orders and receipts

using the Invoice Gateway

In this lesson, you should have learned how to:
• describe the basics of matching invoices to

purchase orders and receipts
• match invoices to purchase orders and receipts

using the Invoice Workbench
• match QuickMatch and PO Default type invoices to

purchase orders and receipts
• match invoices to purchase orders and receipts

using the Invoice Gateway
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Processing Debit and Credit
Memos
Chapter 6



Copyright © Oracle Corporation, 2000. All rights reserved.

Processing Debit and Credit Memos
Chapter 6 - Page 2

Processing Debit and Credit Memos
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Processing Debit and Credit MemosProcessing Debit and Credit Memos

Oracle Payables Release 11iOracle Payables Release 11i

Notations
(N) = Navigator
(T) = Tab
(I) = Icon
(H) = Hyperlink
(B) = Button
(Help) = Oracle Applications Help System
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Online Help
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Online HelpOnline Help

Use the Oracle Payables online HTML Help for
detailed explanations of how to use the product,
including:
• Product functionality
• Window references
• Explanations of the user interface

Use the Oracle Payables online HTML Help for
detailed explanations of how to use the product,
including:
• Product functionality
• Window references
• Explanations of the user interface
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Viewing Online Help
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Viewing Online HelpViewing Online Help

You can view HTML Help in the following ways:
• From an application, use the help icon or the help

menu to open a new Web browser and display
help about that window

• Use the documentation CD
• Use a URL provided by your system administrator
To search for information in the online Help, you can
either use the expandable menu to search for topics
in the menu structure we provide, or use the Search
feature to search for words or phrases.

You can view HTML Help in the following ways:
• From an application, use the help icon or the help

menu to open a new Web browser and display
help about that window

• Use the documentation CD
• Use a URL provided by your system administrator
To search for information in the online Help, you can
either use the expandable menu to search for topics
in the menu structure we provide, or use the Search
feature to search for words or phrases.
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ObjectivesObjectives

After completing this course, you should be able to
do the following:
• Demonstrate how to enter debit and credit memos
• Demonstrate how to match debit and credit

memos
• Describe how to record price corrections

After completing this course, you should be able to
do the following:
• Demonstrate how to enter debit and credit memos
• Demonstrate how to match debit and credit

memos
• Describe how to record price corrections
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Agenda
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AgendaAgenda

• Entering debit and credit memos
• Matching debit and credit memos
• Recording price corrections

• Entering debit and credit memos
• Matching debit and credit memos
• Recording price corrections
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Overview
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OverviewOverview

Receive credit memoReceive credit memo
Create debit memoCreate debit memo

Enter debit or
credit memo

Match toMatch to
invoiceinvoice

Match to PO orMatch to PO or
receipt (andreceipt (and

optionally recordoptionally record
price correction)price correction)
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Agenda

Copyright   Oracle Corporation,  2000.  All rights reserved.
®

AgendaAgenda

• Entering debit and credit memos
• Matching debit and credit memos
• Recording price corrections

• Entering debit and credit memos
• Matching debit and credit memos
• Recording price corrections
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Entering Debit and Credit Memos in the Invoice
Workbench
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Entering Debit and Credit Memos in the
Invoice Workbench

Entering Debit and Credit Memos in the
Invoice Workbench

Enter a credit or debit memo to record a credit for
goods or services purchased. Credit/debit memos are
netted with basic invoices at payment time.
• Credit Memo: Negative amount invoice created by

a supplier and sent to you to notify you of a credit.
• Debit Memo: Negative amount invoice created by

you and sent to a supplier to notify the supplier of
a credit you are recording. Usually sent with a note
explaining the debit memo.

Note: In Oracle Payables, a debit memo and a credit
memo both create the same accounting
entries. The system does not distinguish them as
different transactions.

Enter a credit or debit memo to record a credit for
goods or services purchased. Credit/debit memos are
netted with basic invoices at payment time.
• Credit Memo: Negative amount invoice created by

a supplier and sent to you to notify you of a credit.
• Debit Memo: Negative amount invoice created by

you and sent to a supplier to notify the supplier of
a credit you are recording. Usually sent with a note
explaining the debit memo.

Note: In Oracle Payables, a debit memo and a credit
memo both create the same accounting
entries. The system does not distinguish them as
different transactions.
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Entering Debit and Credit Memos
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Entering Debit and Credit MemosEntering Debit and Credit Memos

You can enter credit memos using the Invoice
Workbench, Invoice Gateway, and the Open Interface.

You can enter debit memos using the Invoice
Workbench.

Note: This module focuses on how to process debit
and credit memos in the Invoice Workbench.

You can enter credit memos using the Invoice
Workbench, Invoice Gateway, and the Open Interface.

You can enter debit memos using the Invoice
Workbench.

Note: This module focuses on how to process debit
and credit memos in the Invoice Workbench.

(Help) Oracle Financial Applications > Oracle Payables > Invoices > Credit
and Debit Memos > Entering Credit/Debit Memos
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Demonstration

Copyright   Oracle Corporation,  2000.  All rights reserved.
®

DemonstrationDemonstration

This demonstration covers how to enter a credit
memo using a distribution set.

(N) Invoices > Entry > Invoices

This demonstration covers how to enter a credit
memo using a distribution set.

(N) Invoices > Entry > Invoices
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Practice 1 Overview
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Practice 1 OverviewPractice 1 Overview

This practice covers entering a credit memo with a
distribution set using the Invoice Workbench.
This practice covers entering a credit memo with a
distribution set using the Invoice Workbench.
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Practice 1 Instructions
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Practice 1 InstructionsPractice 1 Instructions

Advanced Network Devices realized that they have
not given you the discount you were entitled to,
so they are issuing you a $1000.00 credit memo. Enter
the credit memo using the Equipment Expense
(Full) distribution set.
Invoice #: Given to you by the instructor
Date: Today
Terms: Immediate
Supplier: Advanced Network Devices
Description: Discount
Total Due: {$1000}

Advanced Network Devices realized that they have
not given you the discount you were entitled to,
so they are issuing you a $1000.00 credit memo. Enter
the credit memo using the Equipment Expense
(Full) distribution set.
Invoice #: Given to you by the instructor
Date: Today
Terms: Immediate
Supplier: Advanced Network Devices
Description: Discount
Total Due: {$1000}

Practice 1 Solutions
1. Navigate to the Invoices window.
(N) Invoices > Entry > Invoices
2. In the Type field, enter Credit Memo. There will be a note displayed that says
“Payables defaults the payment terms from the supplier site to the invoice. Verify
the payment terms for credit or debit memos. You may want to change the
payment terms to Immediate for credit and debit memos”.
3. Click OK to acknowledge the message.
4. Enter Advanced Network Devices as the supplier.
5. Enter Santa Clara as the site.
6. As the credit memo is dated today, accept the default date.
7. Enter the credit memo number.
8. Enter -1,000 in the Invoice Amount field. Make sure to enter the amount as a
negative value.
9. In the Distribution Set field, enter the Equipment Expense (Full) distribution
set.
10. In the Description field, enter the description for this credit memo.
11. In the Terms field, make sure the terms are Immediate; if they are not, select
Immediate.
12. Choose Distributions.
13. Verify the distributions were created.
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Review QuestionReview Question

In Oracle Payables, a debit memo and a credit memo
create different accounting entries.
1. True
2. False

In Oracle Payables, a debit memo and a credit memo
create different accounting entries.
1. True
2. False
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Answer to Review QuestionAnswer to Review Question

In Oracle Payables, a debit memo and a credit memo
create different accounting entries.
1. True
2. False

In Oracle Payables, a debit memo and a credit memo
create different accounting entries.
1. True
2. False
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AgendaAgenda

• Entering debit and credit memos
• Matching debit and credit memos
• Recording price corrections

• Entering debit and credit memos
• Matching debit and credit memos
• Recording price corrections
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Matching Debit and Credit Memos in the Invoice
Workbench
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Matching Debit and Credit Memos in the
Invoice Workbench

Matching Debit and Credit Memos in the
Invoice Workbench

• You can match a debit or credit memo to existing
invoices, purchase orders, or receipts.

• When you match a debit or credit memo to an
existing invoice, purchase order, or receipt,
Payables automatically copies the accounting
information from the matched document and
creates invoice distributions for the credit memo
or debit memo.

• You can match a debit or credit memo to existing
invoices, purchase orders, or receipts.

• When you match a debit or credit memo to an
existing invoice, purchase order, or receipt,
Payables automatically copies the accounting
information from the matched document and
creates invoice distributions for the credit memo
or debit memo.

(Help) Oracle Financial Applications > Oracle Payables > Invoices > Credit
and Debit Memos > Matching Credit/Debit Memos
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Clearing a Credit
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Clearing a CreditClearing a Credit

If you receive a refund from your supplier, you can
enter the refund to clear a credit or debit memo
you have entered, but have been unable to include in
a payment.

If you receive a refund from your supplier, you can
enter the refund to clear a credit or debit memo
you have entered, but have been unable to include in
a payment.



Copyright © Oracle Corporation, 2000. All rights reserved.

Processing Debit and Credit Memos
Chapter 6 - Page 19

Demonstration
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DemonstrationDemonstration

This demonstration covers how to enter a credit
memo and match it to an invoice.

(N) Invoices > Entry > Invoices (B) Match Invoice (B)
Find

This demonstration covers how to enter a credit
memo and match it to an invoice.

(N) Invoices > Entry > Invoices (B) Match Invoice (B)
Find
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Practice 2 Overview
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Practice 2 OverviewPractice 2 Overview

This practice covers entering a credit memo and
matching it to an invoice.
This practice covers entering a credit memo and
matching it to an invoice.



Copyright © Oracle Corporation, 2000. All rights reserved.

Processing Debit and Credit Memos
Chapter 6 - Page 21
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Practice 2 InstructionsPractice 2 Instructions

Advanced Network Devices has acknowledged
over billing you for the advertising promotional
giveaway items that were recently purchased, and
forwarded the following credit. Prorate the credit over
the invoice distribution lines.
Invoice #: Given to you by the instructor
Date: Today
Terms: Immediate
Supplier: Advanced Network Devices
Total: {$2,000}

Advanced Network Devices has acknowledged
over billing you for the advertising promotional
giveaway items that were recently purchased, and
forwarded the following credit. Prorate the credit over
the invoice distribution lines.
Invoice #: Given to you by the instructor
Date: Today
Terms: Immediate
Supplier: Advanced Network Devices
Total: {$2,000}

Practice 2 Solutions
1. Navigate to the Invoices window.
(N) Invoices > Entry > Invoices
2. In the Type field, enter Credit Memo. Payables opens a window with the
following note “Payables defaults the payment terms from the supplier site to the
Invoice. Verify the payment terms for credit or debit memos. You may want to
change the payment terms to Immediate for credit and debit memos”.
3. Click OK to acknowledge the message.
4. Enter Advanced Network Devices as the supplier.
5. Enter Santa Clara as the site.
6. As the credit memo is dated today, accept the default date.
7. Enter the credit memo number. Write down the number ______________.
8. Enter -2,000 in the Invoice Amount field. Make sure to enter the amount as a
negative value.
9. In the Description field, enter Advertising Items.
10. In the Terms field, make sure the terms are Immediate; if they are not, select
Immediate.
11. In the Invoices window, choose Invoice from the poplist for the Match button.
Select the Match button.
12. To match this credit memo to the original invoice, enter the invoice number
given to you by the instructor. Select the Find button.
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13. In the Match to Invoices window, select the Match check box.
14. In the Credit Amount field, enter -2,000.
15. Select Match.
16. When the matching process is completed, select the Distributions button and
verify that the distributions were created.
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Review QuestionReview Question

Which one of the following can you match a debit
memo and credit memo to?
1. Refund
2. Receipt
3. Payment
4. Prepayment
5. Expense report

Which one of the following can you match a debit
memo and credit memo to?
1. Refund
2. Receipt
3. Payment
4. Prepayment
5. Expense report
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Answer to Review QuestionAnswer to Review Question

Which one of the following can you match a debit
memo and credit memo to?
1. Refund
2. Receipt
3. Payment
4. Prepayment
5. Expense report

Which one of the following can you match a debit
memo and credit memo to?
1. Refund
2. Receipt
3. Payment
4. Prepayment
5. Expense report
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AgendaAgenda

• Entering debit and credit memos
• Matching debit and credit memos
• Recording price corrections

• Entering debit and credit memos
• Matching debit and credit memos
• Recording price corrections
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Recording a Price Correction
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Recording a Price CorrectionRecording a Price Correction

• Use a price correction to record and update the
invoiced unit price of previously matched
purchase orders or receipts without adjusting the
quantity billed in order to track price variances.

• Payables also updates the amount billed on the
originally matched purchase order distributions.

• Use a price correction to record and update the
invoiced unit price of previously matched
purchase orders or receipts without adjusting the
quantity billed in order to track price variances.

• Payables also updates the amount billed on the
originally matched purchase order distributions.

(Help) Oracle Financial Applications > Oracle Payables > Invoices >
Matching to Purchase Orders and Receipts > Recording Price Corrections in
the Invoice Workbench
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How to Record a Price Correction
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How to Record a Price CorrectionHow to Record a Price Correction

• Record a price decrease by entering a debit or
credit memo invoice. Then when matching to a
purchase order or receipt, select the Price
Correction check box in the Find Purchase Orders
for Matching window or Find Receipts for
Matching window.

• Record a price increase by entering a Standard or
PO Default invoice type. Then when matching to a
purchase order or receipt, select the Price
Correction check box.

• Record a price decrease by entering a debit or
credit memo invoice. Then when matching to a
purchase order or receipt, select the Price
Correction check box in the Find Purchase Orders
for Matching window or Find Receipts for
Matching window.

• Record a price increase by entering a Standard or
PO Default invoice type. Then when matching to a
purchase order or receipt, select the Price
Correction check box.
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Demonstration

Copyright   Oracle Corporation,  2000.  All rights reserved.
®

DemonstrationDemonstration

This demonstration covers how to record a price
correction.

(N) Invoices > Entry > Invoices (B) Match Purchase
Order (B) Find

This demonstration covers how to record a price
correction.

(N) Invoices > Entry > Invoices (B) Match Purchase
Order (B) Find
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SummarySummary

In this module, you should have learned how to:
• Process debit and credit memos
• Record price corrections

In this module, you should have learned how to:
• Process debit and credit memos
• Record price corrections
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Chapter 7
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Processing Recurring Invoices
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Processing Recurring InvoicesProcessing Recurring Invoices

Oracle Payables Release 11iOracle Payables Release 11i
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Online Help
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Online HelpOnline Help

Use the Payables online HTML Help for detailed
explanations of how to use the product, including:
Use the Payables online HTML Help for detailed
explanations of how to use the product, including:
• Product functionality
• Window references
• Explanations of the user interface

• Product functionality
• Window references
• Explanations of the user interface
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Viewing Online Help
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Viewing Online HelpViewing Online Help

You can view HTML Help in the following ways:
• From an application, use the help icon or the help

menu to open a new Web browser and display
help about that window

• Use the documentation CD
• Use a URL provided by your system administrator
To search for information in the online Help, you can
either use the expandable menu to search for topics
in the menu structure we provide, or use the Search
feature to search for words or phrases.

You can view HTML Help in the following ways:
• From an application, use the help icon or the help

menu to open a new Web browser and display
help about that window

• Use the documentation CD
• Use a URL provided by your system administrator
To search for information in the online Help, you can
either use the expandable menu to search for topics
in the menu structure we provide, or use the Search
feature to search for words or phrases.
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ObjectivesObjectives

After completing this course, you should be able to:
• Describe the use of recurring invoices
• Define a special calendar
• Define recurring invoice templates
• Create recurring invoices

After completing this course, you should be able to:
• Describe the use of recurring invoices
• Define a special calendar
• Define recurring invoice templates
• Create recurring invoices
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Agenda
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AgendaAgenda

• Recurring invoices overview
• Special calendars
• Recurring invoice templates
• Creating recurring invoices

• Recurring invoices overview
• Special calendars
• Recurring invoice templates
• Creating recurring invoices
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Recurring Invoice Process
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Recurring Invoice ProcessRecurring Invoice Process

CreateCreate
specialspecial

calendarcalendar

Define recurringDefine recurring
invoice templateinvoice template

CreateCreate
recurringrecurring
invoiceinvoice

GenerateGenerate
multiplemultiple
invoicesinvoices
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Agenda
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AgendaAgenda

• Recurring invoices overview
• Special calendars
• Recurring invoice templates
• Creating recurring invoices

• Recurring invoices overview
• Special calendars
• Recurring invoice templates
• Creating recurring invoices
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Overview of Recurring Invoices
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Overview of Recurring InvoicesOverview of Recurring Invoices

You can create recurring invoices for periodic
business expenses for which you may not receive
invoices (for example, monthly rent or lease
payments).

You can create recurring invoices for periodic
business expenses for which you may not receive
invoices (for example, monthly rent or lease
payments).
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Overview of Recurring Invoices
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Overview of Recurring InvoicesOverview of Recurring Invoices

To enter recurring invoices, perform the following
steps:
1.  Define periods in the Special Calendar window
2.  Define a recurring invoice template
3.  Create invoices based on the template

To enter recurring invoices, perform the following
steps:
1.  Define periods in the Special Calendar window
2.  Define a recurring invoice template
3.  Create invoices based on the template
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Overview of Recurring Invoices
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Overview of Recurring InvoicesOverview of Recurring Invoices

When you define a recurring invoice template you can:
• Specify how frequently the invoices based on this

recurring invoice template will be created.
• Create up to two one-time invoices for non-

standard amounts (for example, a deposit or a
balloon payment).

• Allow invoice amounts to increase or decrease by a
fixed percentage from period to period.

When you define a recurring invoice template you can:
• Specify how frequently the invoices based on this

recurring invoice template will be created.
• Create up to two one-time invoices for non-

standard amounts (for example, a deposit or a
balloon payment).

• Allow invoice amounts to increase or decrease by a
fixed percentage from period to period.
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Agenda
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AgendaAgenda

• Recurring invoices overview
• Special calendars
• Recurring invoice templates
• Creating recurring invoices

• Recurring invoices overview
• Special calendars
• Recurring invoice templates
• Creating recurring invoices
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Special Calendar WindowSpecial Calendar Window

Use the Special Calendar window to define the
periods Payables uses for:
Use the Special Calendar window to define the
periods Payables uses for:

• Recurring invoices
• Automatic withholding tax
• Payment terms
• The Key Indicators Report

• Recurring invoices
• Automatic withholding tax
• Payment terms
• The Key Indicators Report

(Help) Oracle Financial Applications > Oracle Payables > Setup >
Controlling the Status of AP Accounting Periods > Special Calendar
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Demonstration
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DemonstrationDemonstration

This demonstration shows an example of a Special
Calendar and covers how to define a calendar for a
recurring invoice.

(N) Setup—>Calendar—>Special Calendar

This demonstration shows an example of a Special
Calendar and covers how to define a calendar for a
recurring invoice.

(N) Setup—>Calendar—>Special Calendar
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Review QuestionReview Question

Which is not a type of calendar defined in the Special
Calendar window?
1. Key Indicator
2. Accounting Calendar
3. Recurring Invoice
4. Payment Terms
5. Withholding Tax

Which is not a type of calendar defined in the Special
Calendar window?
1. Key Indicator
2. Accounting Calendar
3. Recurring Invoice
4. Payment Terms
5. Withholding Tax
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Answer to Review QuestionAnswer to Review Question

Which is not a type of calendar defined in the Special
Calendar window?
1. Key Indicator
2. Accounting Calendar
3. Recurring Invoice
4. Payment Terms
5. Withholding Tax

Which is not a type of calendar defined in the Special
Calendar window?
1. Key Indicator
2. Accounting Calendar
3. Recurring Invoice
4. Payment Terms
5. Withholding Tax
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Agenda
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AgendaAgenda

• Recurring invoices overview
• Special calendars
• Recurring invoice templates
• Creating recurring invoices

• Recurring invoices overview
• Special calendars
• Recurring invoice templates
• Creating recurring invoices
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Recurring Invoice TemplatesRecurring Invoice Templates

Prerequisites:
• Define periods in the Special Calendar window.
• Define a full distribution set if you want to use a

distribution set for the recurring invoices.

Prerequisites:
• Define periods in the Special Calendar window.
• Define a full distribution set if you want to use a

distribution set for the recurring invoices.

Use the recurring invoice template to establish the
basic information for standard invoices that are
generated on a regular basis.

Use the recurring invoice template to establish the
basic information for standard invoices that are
generated on a regular basis.
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Recurring Invoice Templates
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Recurring Invoice TemplatesRecurring Invoice Templates

• The invoice date is the first date of the period in
which the invoice is created.

• The terms date depends on the terms date basis
setting at the supplier site, but the date is
calculated differently than for regular invoices.
– If the terms date basis is equal to the system

date, then the terms date is the same date that
the recurring invoice was created.

– If the terms date basis is not equal to the
system date, then the terms date is the invoice
date.

• The invoice date is the first date of the period in
which the invoice is created.

• The terms date depends on the terms date basis
setting at the supplier site, but the date is
calculated differently than for regular invoices.
– If the terms date basis is equal to the system

date, then the terms date is the same date that
the recurring invoice was created.

– If the terms date basis is not equal to the
system date, then the terms date is the invoice
date.
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Recurring Invoice Templates
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Recurring Invoice TemplatesRecurring Invoice Templates

Enter a template number that is unique for the
supplier.  Payables generates an invoice number for
each invoice by appending the name of the recurring
invoice period to the template number.

Enter a template number that is unique for the
supplier.  Payables generates an invoice number for
each invoice by appending the name of the recurring
invoice period to the template number.

(Help) Oracle Financial Applications > Oracle Payables > Invoices >
Recurring Invoices > Defining a Recurring Invoice Template
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Demonstration
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DemonstrationDemonstration

This demonstration shows an example of a recurring
invoice template and covers how to define a recurring
invoice template to automatically create recurring
invoices.

(N) Invoices—>Entry—>Recurring Invoices

This demonstration shows an example of a recurring
invoice template and covers how to define a recurring
invoice template to automatically create recurring
invoices.

(N) Invoices—>Entry—>Recurring Invoices
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Review QuestionReview Question

You are allowed ____ special invoice amounts when
you define a recurring invoice template.
1. One
2. Two
3. Three
3. Either one or two
4. This feature is not currently available

You are allowed ____ special invoice amounts when
you define a recurring invoice template.
1. One
2. Two
3. Three
3. Either one or two
4. This feature is not currently available
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Answer to Review QuestionAnswer to Review Question

You are allowed ____ special invoice amounts when
you define a recurring invoice template.
1. One
2. Two
3. Three
4. Either one or two
5. None of the above

You are allowed ____ special invoice amounts when
you define a recurring invoice template.
1. One
2. Two
3. Three
4. Either one or two
5. None of the above
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AgendaAgenda

• Recurring invoices overview
• Special calendars
• Recurring invoice templates
• Creating recurring invoices

• Recurring invoices overview
• Special calendars
• Recurring invoice templates
• Creating recurring invoices
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Creating a Recurring Invoice
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Creating a Recurring InvoiceCreating a Recurring Invoice

To create a recurring invoice:
• Choose a predefined recurring invoice template
• (Optional) Name the batch
• Specify exchange rates

To create a recurring invoice:
• Choose a predefined recurring invoice template
• (Optional) Name the batch
• Specify exchange rates

(Help) Oracle Financial Applications > Oracle Payables > Invoices >
Recurring Invoices > Creating Recurring Invoices



Copyright © Oracle Corporation, 2000. All rights reserved.

Processing Recurring Invoices
Chapter 7 - Page 26

Recurring Credit and Debit Memos
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Recurring Credit and Debit MemosRecurring Credit and Debit Memos

You can create recurring credit or debit memos by
defining a recurring invoice template and using
negative invoice amounts.

You can create recurring credit or debit memos by
defining a recurring invoice template and using
negative invoice amounts.
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Withholding Taxes from Recurring Invoices
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Withholding Taxes from Recurring InvoicesWithholding Taxes from Recurring Invoices

When you define a recurring invoice template, enter a
Withholding Tax Group.  This group will be applied to
all invoices you create for that template.

When you define a recurring invoice template, enter a
Withholding Tax Group.  This group will be applied to
all invoices you create for that template.

(Help) Oracle Financial Applications > Oracle Payables > Invoices >
Recurring Invoices > Withholding Taxes from Recurring Invoices
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Recurring Invoice Restrictions
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Recurring Invoice RestrictionsRecurring Invoice Restrictions

After you create an invoice using a recurring invoice
template, you cannot update the following fields:
After you create an invoice using a recurring invoice
template, you cannot update the following fields:

• Supplier Name
• Supplier Number
• Supplier Site
• Type
• First Period Number
• Currency
• GL Date

• Supplier Name
• Supplier Number
• Supplier Site
• Type
• First Period Number
• Currency
• GL Date
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Demonstration
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DemonstrationDemonstration

This demonstration shows an example of an invoice
that is created using a recurring invoice template.

(N) Invoices —>Entry—>Recurring Invoices (B) Create
Invoices

This demonstration shows an example of an invoice
that is created using a recurring invoice template.

(N) Invoices —>Entry—>Recurring Invoices (B) Create
Invoices
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Practice Overview
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Practice OverviewPractice Overview

You will define a recurring payment template to
handle the creation of invoices.
You will define a recurring payment template to
handle the creation of invoices.

(Help) Oracle Financial Applications > Oracle Payables > Invoices >
Recurring Invoices > Creating Recurring Invoices
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Practice Instructions
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Practice InstructionsPractice Instructions

• You have signed a six month lease for a total of
$12,000 for the entire period.  You do not receive
an invoice for the rent you pay to your supplier.

• Define a recurring payment to handle the creation
of all the invoices for $2,000 for this supplier
starting with the first of the next month.

• Enter the following:
– Supplier Name:  Advanced Network Devices
– Site:  Santa Clara
– Calendar Name:  Monthly

• You have signed a six month lease for a total of
$12,000 for the entire period.  You do not receive
an invoice for the rent you pay to your supplier.

• Define a recurring payment to handle the creation
of all the invoices for $2,000 for this supplier
starting with the first of the next month.

• Enter the following:
– Supplier Name:  Advanced Network Devices
– Site:  Santa Clara
– Calendar Name:  Monthly

Solution to the practice exercise:
1. Navigate to the Recurring Invoices window.

(N) Invoices > Entry > Recurring Invoices (B) Create Invoices.
2. Enter the following Supplier Region information:

Name:  Advanced Network Devices
Site:  Santa Clara

3. Enter the following Calendar Region information:
Name:  Monthly
Number of Periods:  6
First:  Next Month

4. Enter the following Template Definition information:
Number:  Assign a number
Description:  Monthly Rent
Payment Method:  Check
Accept the default values for the remainder of the fields.
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Review QuestionReview Question

Payables creates invoice numbers for recurring invoices
by appending the name of the  _______ to the _______.
1.  Payment number / period name
2.  Payment number / current date
3.  Supplier number / period name
4.  Site / pay group
5.  Recurring invoice period / template number

Payables creates invoice numbers for recurring invoices
by appending the name of the  _______ to the _______.
1.  Payment number / period name
2.  Payment number / current date
3.  Supplier number / period name
4.  Site / pay group
5.  Recurring invoice period / template number
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Answer to Review QuestionAnswer to Review Question

Payables creates invoice numbers for recurring invoices
by appending the name of the  _______ to the _______.
1.  Payment number / period name
2.  Payment number / current date
3.  Supplier number / period name
4.  Site / pay group
5.  Recurring invoice period / template number

Payables creates invoice numbers for recurring invoices
by appending the name of the  _______ to the _______.
1.  Payment number / period name
2.  Payment number / current date
3.  Supplier number / period name
4.  Site / pay group
5.  Recurring invoice period / template number
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SummarySummary

In this lesson, you should have learned how to:
• Create special calendars for recurring invoices
• Define recurring invoice templates
• Create recurring invoices

In this lesson, you should have learned how to:
• Create special calendars for recurring invoices
• Define recurring invoice templates
• Create recurring invoices
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